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Εργαλεία Express 

 
Τα εργαλεία GstarCAD Express Tools περιέχουν μια βιβλιοθήκη εργαλείων παραγωγικότητας που έχουν σχεδιαστεί για να 

σας βοηθήσουν να επεκτείνετε την ισχύ του σχεδιασμού σας. Είναι εύχρηστα, ενσωματώνονται εύκολα στα μενού και 

τις γραμμές εργαλείων σας και καλύπτουν ένα ευρύ φάσμα λειτουργιών, όπως η διαστασιολόγηση, η σχεδίαση και 

η επιλογή και τροποποίηση αντικειμένων. Τα εργαλεία GstarCAD Express Tools είναι οργανωμένα σε: 

 
1. Εργαλεία μπλοκ 

 

 
Αλλαγή βάσης: Η εντολή CHANGEBASE επιτρέπει την 

αλλαγή της θέσης του σημείου βάσης ενός μπλοκ. 

Μπορείτε να μετακινήσετε το σημείο βάσης και να 

διατηρήσετε τα αντικείμενα στην ίδια θέση ή να 

μετακινήσετε τα αντικείμενα και να διατηρήσετε το σημείο 

βάσης στην ίδια θέση 

 
Μενού: Μπλοκ>Αλλαγή βάσης Εισαγωγή 

εντολής: CHANGEBASE 

 

 
Διακοπή μπλοκ: Η εργασία με αναφορές μπλοκ που αντιπροσωπεύουν σύμβολα είναι απαραίτητη σε ορισμένα σχέδια 

βιομηχανικών εφαρμογών, όπως ηλεκτρικά σχέδια, σωληνώσεις κ.λπ. 

Αλλά ο πονοκέφαλος έρχεται όταν προσπαθείτε να τοποθετήσετε αυτά τα μπλοκ με ακρίβεια επικαλύπτοντας ή 

ακόμη και σπάζοντας άλλα αντικείμενα στο σχέδιό σας. 

Τώρα απαλλαγείτε από αυτόν τον πονοκέφαλο με την εντολή BLOCKBREAK. Αυτό το καινοτόμο εργαλείο είναι σε θέση να 

σβήσει ή να σπάσει ένα αντικείμενο που επικαλύπτεται από ένα μπλοκ αναφοράς. 

Για παράδειγμα, σε ορισμένες περιπτώσεις μπορεί να χρειαστεί να εισάγουμε σύμβολα μπλοκ σε μια γραμμή 

καλωδίου σε ηλεκτρικό διάγραμμα. Και κανονικά απαιτείται η γραμμή καλωδίων να διακόπτεται από τα σύμβολα στο 

σημείο όπου εισάγονται τα σύμβολα. Παρόμοιο αίτημα υπάρχει και σε άλλα σχέδια εφαρμογών. 

 
Μενού: Μπλοκ>Διακοπή μπλοκ 

Εισαγωγή εντολής: BLOCKBREAK 

 
Παράθυρο διαλόγου Διακοπή μπλοκ: 

Όνομα: Λίστα όλων των διαθέσιμων μπλοκ που 

δημιουργήθηκαν στο σχέδιο. 

Περιηγηθείτε: Αναζήτηση για να ανοίξετε συγκεκριμένο αρχείο  
σχεδίασης. 

Επιλογή: Μπορείτε να επιλέξετε μια υπάρχουσα 

αναφορά μπλοκ στο τρέχον σχέδιο. 

Κλίμακα: Κλίμακα του μεγέθους αναφοράς του 

μπλοκ σύμφωνα με τις συντεταγμένες X, Y και Z. 

Η επιλογή Uniform Scale διατηρεί το αρχικό 
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μέγεθος του μπλοκ αναφοράς. 

Περιστροφή: Μπορείτε να περιστρέψετε ένα 

μπλοκ αναφοράς εισάγοντας μια τιμή γωνίας ή 

να διατηρήσετε την ευθυγράμμιση. 

Λειτουργία διαδικασίας: Μπορείτε να 

χρησιμοποιήσετε μια αναφορά μπλοκ για να 

σπάσετε ή να σβήσετε αντικείμενα όταν 

επικαλύπτονται. 

Απεικόνιση λειτουργίας διεργασίας Block Break 

Διάλειμμα: Σπάει το(τα) αντικείμενο(α) φόντου όταν επικαλύπτεται μια αναφορά μπλοκ. 
 

 
Wipeout: όταν επικαλύπτεται μια αναφορά μπλοκ. 

 

 
Αντικατάσταση μπλοκ με άλλο μπλοκ: Μπορείτε να χρησιμοποιήσετε 

ένα μπλοκ στο τρέχον σχέδιο για να αντικαταστήσετε ένα άλλο. 

Επιπλέον, μπορείτε να καθαρίσετε το μπλοκ χωρίς αναφορά όταν 

ολοκληρωθεί η λειτουργία. 
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Μενού: Εισαγωγή εντολής: 

Expresstools>Blocks>ReplaceBlock: 

BLOCKREPLACE 

 
Επιλέξτε ένα μπλοκ προς αντικατάσταση: Διπλό 

κρεβάτι. Στη συνέχεια επιλέξτε: OK Επιλέξτε το 

μπλοκ προς αντικατάσταση: Καναπές. Στη συνέχεια 

επιλέξτε: OK Καθαρισμός μη αναφερόμενων 

στοιχείων όταν ολοκληρωθεί; Ναι/Όχι 

 
 
 
 

 
Δείτε το αποτέλεσμα παρακάτω: 

 

 

 

 

 

 

 

Αντιγραφή φωλιασμένων αντικειμένων: Αντιγραφή αντικειμένων σε ένα xref ή ένα μπλοκ. 

 
Μενού: Εισαγωγή εντολής: 

Express>Blocks>Copy Nested Objects: NCOPY 

 
Οι οδηγίες στη γραμμή εντολών έχουν ως εξής: 

 
Επιλέξτε φωλιασμένα αντικείμενα για αντιγραφή: Χρησιμοποιήστε μια μέθοδο επιλογής αντικειμένων 

Σημείο βάσης: ή πληκτρολογήστε M για πολλαπλά αντίγραφα 

Καθορίστε το δεύτερο σημείο ή <χρησιμοποιήστε το πρώτο σημείο ως μετατόπιση>: Καθορίστε ένα σημείο 
 
 

 

Εξερρίψτε το χαρακτηριστικό σε κείμενο: Explode blocks, μετατρέποντας την τιμή των 

χαρακτηριστικών σε αντικείμενα κειμένου. Μενού: Express>Blocks>Explode 

Attributes to Text 

Είσοδος εντολών: BURST 
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Οι οδηγίες στη γραμμή εντολών έχουν ως εξής: Επιλέξτε οντότητες: Χρησιμοποιήστε μια μέθοδο επιλογής αντικειμένων 

 
Για παράδειγμα: Explode attributes και μετατροπή τους σε αντικείμενα κειμένου. 

 
1. Επιλέξτε ένα μπλοκ που περιέχει δύο χαρακτηριστικά. 2. Το μπλοκ εκρήγνυται και οι τιμές των χαρακτηριστικών μετατρέπονται σε 
κείμενο. 

 

 
 
 

 
Αύξηση χαρακτηριστικών: ATTINC: Η εντολή ATTINC βοηθά στον καθορισμό των χαρακτηριστικών των μπλοκ με αυξητική 

τιμή και στην τροποποίηση της τιμής των χαρακτηριστικών των μπλοκ σύμφωνα με τη μέθοδο ταξινόμησης. 

 
Μενού: Εισαγωγή εντολής: 

Express>Blocks>Attribute Increment: 

ATTINC 

 
Αυτή η εντολή μπορεί να αυξήσει την τιμή του χαρακτηριστικού μπλοκ που περιέχει έναν αριθμό ή ένα γράμμα. Όταν η 

εντολή ATTINC είναι ενεργοποιημένη, εφόσον το σχέδιο δεν είναι κλειστό, κατά την αντιγραφή, την εισαγωγή και τη 

διαγραφή ενός χαρακτηριστικού μπλοκ στο σχέδιο, ο αριθμός ή το γράμμα της ιδιότητας μπορεί να ενημερωθεί 

αυτόματα. 

 

Εξαγωγή πληροφοριών χαρακτηριστικών: Εξαγωγή χαρακτηριστικών μπλοκ σε ένα εξωτερικό αρχείο 

σε μορφή ASCII με διαχωρισμένες καρτέλες. Μενού: Express>Μπλοκ>Εξαγωγή πληροφοριών 



7 
 

χαρακτηριστικών 

Είσοδος εντολών: ATTOUT 

 
Αφού εκτελέσετε την εντολή ATTOUT, καθορίστε το όνομα αρχείου και τη διαδρομή αποθήκευσης στο πλαίσιο 

διαλόγου "Enter output filename" (Εισαγωγή ονόματος αρχείου εξόδου), στη συνέχεια, η γραμμή εντολών σας καλεί: 

Επιλέξτε οντότητες: Καθορίστε τα μπλοκ των οποίων τα χαρακτηριστικά θέλετε να εξαγάγετε. 

 
Τα ονόματα και τα χαρακτηριστικά των μπλοκ 

εξάγονται στο αρχείο που ονομάζεται. Εάν το 

αρχείο υπάρχει ήδη, σας ζητείται να το 

αντικαταστήσετε πριν από την αντικατάστασή 

του. Μπορείτε εύκολα να προβάλετε τα 

χαρακτηριστικά σε μορφή φύλλου εργασίας και 

να επεξεργαστείτε μεμονωμένες τιμές 

χαρακτηριστικών. Στη συνέχεια, μπορείτε να 

εισαγάγετε τις νέες τιμές στο αρχείο σχεδίασης, 

χρησιμοποιώντας την εντολή ATTIN. 

Εισαγωγή πληροφοριών χαρακτηριστικών: Εισαγωγή χαρακτηριστικών μπλοκ σε ένα εξωτερικό 

αρχείο σε μορφή ASCII με διαχωρισμένες καρτέλες. Μενού: Express>Μπλοκ>Εισαγωγή 

πληροφοριών χαρακτηριστικών 

Είσοδος εντολών: ATTIN 

Χρησιμοποιώντας τα ATTIN και ATTOUT μαζί, μπορείτε να κάνετε γρήγορα αλλαγές στις τιμές των χαρακτηριστικών για 

επιλεγμένες αναφορές μπλοκ. Μόλις εκτελεστεί αυτή η εντολή, 

το παράθυρο διαλόγου "Enter 

input filename" θα εμφανιστεί για 

να αναζητήσει ο χρήστης το 

αρχείο, να εισάγει τα 

χαρακτηριστικά του μπλοκ μαζί 

με την ίδια λαβή και το όνομα 

του μπλοκ στο σχέδιο και να κάνει 

αλλαγές στα χαρακτηριστικά 

του μπλοκ. 

Μόλις μια τιμή χαρακτηριστικού είναι 
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τροποποιηθεί, θα ενσωματωθεί στο καθορισμένο μπλοκ. Πρέπει να σημειωθεί ότι το εισαγόμενο αρχείο δεν μπορεί να 

είναι αρχείο χαρακτηριστικών που εξάγεται με την εντολή ATTOUT, ενώ η μορφή του αρχείου πρέπει να είναι ίδια με 

εκείνη της εξαγωγής με την εντολή ATTOUT. 

 
Διαβάζει το εισαγόμενο αρχείο και επεξεργάζεται κάθε γραμμή κατά την εκτέλεση της εντολής ATTIN. Εάν το μπλοκ με 

την ίδια λαβή και το ίδιο όνομα βρεθεί κατά τη διαδικασία επεξεργασίας των γραμμών, θα εφαρμοστεί η 

τροποποιημένη τιμή χαρακτηριστικού αυτού του μπλοκ. Εάν βρεθούν πολλά μπλοκ με την ίδια λαβή και το ίδιο 

όνομα, τότε το σύστημα ζητάει να αναθέσει διαδραστικά την αποθήκευση δεδομένων κατά την επεξεργασία αυτών 

των μπλοκ. Εάν επιλεγεί το "Ναι", τα δεδομένα κάθε γραμμής εντολών θα παρατίθενται και θα επιτρέπουν την 

επιλογή ενός μπλοκ για την εφαρμογή αυτού του χαρακτηριστικού. Πατήστε ENTER για να μεταβείτε στην επόμενη 

γραμμή, πατήστε ESC για έξοδο. 

 
Επεξεργασία χαρακτηριστικού μπλοκ στη θέση του: Σας επιτρέπει να επεξεργάζεστε τα περιεχόμενα κειμένου ενός 

χαρακτηριστικού ενός μπλοκ, όταν θέλετε να επεξεργαστείτε τις τιμές του χαρακτηριστικού χωρίς να έχετε πρόσβαση 

στον επεξεργαστή χαρακτηριστικών. 

 
Μενού: Επιλογή εντολής: Express>Blocks>Edit Block 

Attribute in Place: ATTIPEDIT 

 

Στατιστικά στοιχεία Αριθμός μπλοκ: Μπορείτε να κάνετε στατιστικά στοιχεία για την ποσότητα των 

διαφόρων μπλοκ μέσω αυτής της λειτουργίας. Μενού: Στατιστικά Αριθμός μπλοκ 

Είσοδος εντολών: BLKNUM 
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Μετρήστε τα μπλοκ: Αυτή η λειτουργία χρησιμοποιείται για την καταμέτρηση του αριθμού των μπλοκ ανά λίστα. 

 
Μόλις εκτελεστεί αυτή η εντολή, θα εμφανιστεί το σχετικό παράθυρο διαλόγου. Στην περιοχή Stat. Condition, μπορείτε 

να εισαγάγετε ένα όνομα μπλοκ, ένα στρώμα ή να ελέγξετε τις επιλογές: Αγνοήστε τα μπλοκ στο ίδιο σημείο 

εισαγωγής και επίσης αγνοήστε την κλίμακα. 

 

 

 

 

 

 

 

 

 

 

 

 

Μενού: Εισαγωγή εντολής: 

Express>Blocks>Count Blocks: BCOUNT 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή, η γραμμή 

εντολών ζητά "Enter για να επιλέξετε 

όλα τα μπλοκ ή ...". 

2. Μπορείτε να πατήσετε enter για να 

επιλέξετε όλα τα μπλοκ μέσα στο 

σχέδιο ή επιλέγοντας μπλοκ. 

3. Μόλις πατήσετε το "Enter", το σύστημα θα εμφανίσει το αποτέλεσμα στη γραμμή εντολών. 

 
Αλλαγή χρώματος μπλοκ: Τροποποιήστε γρήγορα το χρώμα του μπλοκ. 
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Μενού: Εισαγωγή εντολής: bChgCol 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Εισάγετε νέο αριθμό χρώματος, εδώ εισάγουμε 30 για παράδειγμα. 

3. Επιλέξτε αντικείμενα μπλοκ, για τα οποία πρέπει να αλλάξετε το χρώμα. 

4. Τελείωσε η τροποποίηση. 

Αλλαγή εύρους γραμμής μπλοκ: Αυτή η λειτουργία μπορεί να 

τροποποιήσει γρήγορα το εύρος γραμμής μπλοκ. Μενού: 

Μπλοκ>Αλλαγή εύρους γραμμής μπλοκ 

Είσοδος εντολής: bChgWid 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Εισάγετε μια νέα τιμή πλάτους γραμμής. 

3. Επιλέξτε αντικείμενα μπλοκ, για τα οποία πρέπει να αλλάξετε τα πλάτη γραμμών. 

4. Ολοκληρώστε την αλλαγή του πλάτους της γραμμής. 

 
Αλλαγή γωνίας κειμένου μπλοκ: Η λειτουργία αυτή μπορεί να αλλάξει τη γωνία περιστροφής του κειμένου του μπλοκ 

και ισχύει μόνο για το κείμενο ή το mtext, το κείμενο των χαρακτηριστικών δεν μπορεί να αλλάξει. 

 
Μενού: Εισαγωγή εντολής: bChgAng 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Εισαγωγή νέου κειμένου angle(συγκριτικό με @)<0>: εισαγωγή 0. 

3. Επιλέξτε το μπλοκ για να αλλάξετε τη γωνία του κειμένου: και στη συνέχεια Επιλέξτε αντικείμενα: 

4. Ολοκληρώστε την αλλαγή της γωνίας του κειμένου. 
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Αλλαγή ύψους κειμένου μπλοκ: Αυτή η λειτουργία μπορεί να αλλάξει το ύψος του μπλοκ, έχει αποτέλεσμα μόνο σε 

κείμενο ή mtext, το κείμενο των χαρακτηριστικών δεν μπορεί να αλλάξει. 

 
Μενού: Εισαγωγή εντολών: bChgHei 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Εισάγετε μια νέα τιμή ύψους κειμένου. 

3. Επιλέξτε αντικείμενα των οποίων τα ύψη κειμένου πρέπει να αλλάξουν. 

4. Enter για να ολοκληρώσετε την εντολή. 
 

 
Αλλαγή στρώματος μπλοκ: Αυτή η λειτουργία 

μπορεί να αλλάξει το στρώμα μπλοκ. 

 
Μενού: Εισαγωγή εντολής: bChgLay 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Όνομα στρώματος στόχου εισόδου. 

3. Επιλέξτε αντικείμενα μπλοκ για να αλλάξετε στρώμα. 

4. Πατήστε Enter. Εάν υπάρχει το στρώμα-στόχος, το επιλεγμένο μπλοκ θα μετακινηθεί στο στρώμα-στόχο, εάν δεν 

υπάρχει στόχος, το λογισμικό θα δημιουργήσει αυτόματα ένα νέο στρώμα και θα μετακινήσει το αντικείμενο του 

μπλοκ στο νέο στρώμα. 

 

 
Μετατροπή BLOCK σε XREF: Αντικαταστήστε όλες τις 

περιπτώσεις ενός τυπικού μπλοκ με ένα xref. Αποδεσμεύστε 

τα xrefs που είναι δεσμευμένα. 

 
Μενού: Express>Blocks>Convert Block to Xref 

Εισαγωγή εντολής: Express>Blocks>Convert 

Block to Xref: BLOCKTOXREF 

 
Η επιλογή -BLOCKTOXREF αναζητά σε ολόκληρο το σχέδιο αναφορές σε ένα καθορισμένο όνομα μπλοκ και τις αντικαθιστά 

με ένα xref που καθορίζετε. Όταν τελειώσετε, μπορείτε να καθαρίσετε το μπλοκ χωρίς παραπομπές. Στο παράθυρο 

διαλόγου BLOCKTOXREF. Επιλέξτε ένα μπλοκ προς αντικατάσταση: Τραπέζι και 4 καρέκλες. Στη συνέχεια επιλέξτε 

το κουμπί OK. 

 
-Επιλογή αρχείου Xref. Επιλέξτε το Xref που θέλετε. Στη 

συνέχεια, επιλέξτε το κουμπί Άνοιγμα. 

Καθαρίστε τα μη αναφερόμενα στοιχεία όταν τελειώσετε; Ναι/Όχι 
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Λίστα ιδιοτήτων Xref/Block: Λίστα με τον τύπο, το όνομα του μπλοκ, το όνομα του στρώματος, το χρώμα και τον τύπο 

γραμμής ενός εμφωλευμένου αντικειμένου σε ένα μπλοκ ή ένα xref. 

 
Μενού: Express>Blocks>List Xref/Block Properties 

Εντολή Εισαγωγή: Express>Blocks>List Xref/Block 

Properties: XLIST 

 
Οι εντολές της γραμμής εντολών είναι οι εξής: Επιλέξτε ένθετο αντικείμενο 

xref ή μπλοκ για λίστα: Χρησιμοποιήστε μια μέθοδο επιλογής αντικειμένου. 

Μετά την επιλογή μιας εξωτερικής αναφοράς, το παράθυρο διαλόγου "Xref/Block 

object" θα εμφανίσει τα χαρακτηριστικά των καθορισμένων μπλοκ και xref, 

συμπεριλαμβανομένου του τύπου αντικειμένου, του ονόματος του μπλοκ, του 

χρώματος και του τύπου γραμμής. 

Περικοπή σε ένθετα αντικείμενα: Κοπή αντικειμένων με ένα μπλοκ ως 

όριο κοπής. Μενού: Μπλοκ>Περικοπή σε ένθετα αντικείμενα 

Είσοδος εντολών: BTRIM 

 
Οι εντολές της γραμμής εντολών είναι οι εξής: 

-Επιλογή αντικειμένων ή <επιλογή όλων>: 

Επιλέξτε ένα ή περισσότερα μπλοκ και 

πατήστε ENTER. 

-Επιλέξτε το αντικείμενο για περικοπή ή 

επιλέξτε με Shift για επέκταση ή 

[Edge/Fence/Crossing/Project]: Επιλέξτε 

αντικείμενο(α) ή εισαγάγετε μια επιλογή και 

πατήστε ENTER. 

 
Επέκταση σε φωλιασμένα αντικείμενα: Επεκτείνει αντικείμενα όπως τμήμα γραμμής, τόξο, πολυγραμμή ή ακτίνα σε 

ένα μπλοκ. Τα αντικείμενα θα επεκτείνονται σε ένα μπλοκ όσο το δυνατόν πιο κοντά, εάν δεν μπορούν να 

τέμνονται μεταξύ τους. 

 
Μενού: Επέκταση σε εμφωλευμένα 

αντικείμενα 

Είσοδος εντολών: BEXTEND 

 
Οι εντολές της γραμμής εντολών είναι οι εξής: 

-Επιλογή αντικειμένων ή <επιλογή όλων>: 

Επιλέξτε ένα ή περισσότερα μπλοκ και 

πατήστε ENTER. 

-Επιλέξτε το αντικείμενο για επέκταση ή Shift-επιλογή για περικοπή 

ή [Edge/Fence/Crossing/Project]: Επιλέξτε αντικείμενο(α) ή εισάγετε μια επιλογή και πατήστε ENTER. 
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Εξωτερική αναφορά Relocate: Εάν θέλετε να επιλέξετε μια 

άλλη διαδρομή αναφοράς, κάντε κλικ στο κουμπί 

"Μετατόπιση" και η αναφορά θα εμφανιστεί ξανά στο 

σχέδιο. 

 
Μενού: Express>Blocks>Εξωτερική αναφορά 

Μετατόπιση εντολής Εισαγωγή: 

Express>Blocks>External Reference: CHGXREFPATHa 

 

 

Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή και θα εμφανιστεί ένα παράθυρο διαλόγου. 

2. Επιλέξτε το όνομα της εξωτερικής αναφοράς που θέλετε να τροποποιήσετε. 

3. Αν κάνετε κλικ στο κουμπί "Σχετική διαδρομή", θα λάβετε μια σχετική διαδρομή της αναφοράς.Αν κάνετε κλικ στο 

κουμπί "Μετατόπιση", το σύστημα θα μετατοπίσει την εξωτερική αναφορά. 

 

 

 

2. Εργαλεία κειμένου 

 
Αιτιολογήστε το κείμενο: Αλλάξτε την αιτιολόγηση ενός αντικειμένου κειμένου χωρίς να αλλάξετε τη θέση του. Λειτουργεί 

με αντικείμενα κειμένου, mtext και ορισμού χαρακτηριστικών. 

 
Μενού: Εισαγωγή εντολής: TJUST 

 
Επιλέξτε αντικείμενα: Χρησιμοποιήστε μια μέθοδο επιλογής αντικειμένων. 

[Start/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR] <Start>:  Επιλέξτε τη νέα αιτιολόγηση 

 
Παράδειγμα χρήσης: κείμενο σε μεσαία στοίχιση 

-Κείμενο αριστερά δικαιολογημένο. -Κείμενο μετά την αλλαγή της ευθυγράμμισης. 

 

 

 
Περιστροφή κειμένου: Ευθυγραμμίζει το κείμενο, το mtext και τα αντικείμενα με χαρακτηριστικά μπλοκ σε νέο 

προσανατολισμό. Περιστρέφει το κείμενο, το mtext και τα αντικείμενα ορισμού χαρακτηριστικών έτσι ώστε να 

καταλήγουν να είναι όσο το δυνατόν πιο κοντά στην οριζόντια ή δεξιά ανάγνωση (παρόμοια με τη συμπεριφορά του 

κειμένου διαστάσεων). Τα αντικείμενα περιστρέφονται γύρω από το μεσαίο σημείο τους σε βήματα 180 μοιρών. Για 

παράδειγμα, εάν το κείμενο είναι ανάποδα, γίνεται δεξιά μετά από μια πράξη TORIENT. Ομοίως, το κείμενο που 

διαβάζεται από αριστερά γίνεται κείμενο που διαβάζεται από δεξιά. 
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Μενού: Εισαγωγή εντολής: Express > 

Εργαλεία κειμένου > Περιστροφή κειμένου: 

TORIENT 

 
-Επιλογή αντικειμένων: Χρησιμοποιήστε μια μέθοδο επιλογής αντικειμένων 

-Νέα απόλυτη περιστροφή <0>:Εισάγετε μια νέα απόλυτη 

γωνία προσανατολισμού για όλο το επιλεγμένο κείμενο. 

Παράδειγμα χρήσης: -Κείμενο πριν από την περιστροφή (Εικ. 3)

 -Κείμενο μετά την περιστροφή 

καθορισμένη γωνία 0 μοίρες (Εικ. 4) 

 

 
Αλλαγή στυλ κειμένου: Αυτή η λειτουργία μπορεί να αλλάξει το τρέχον στυλ κειμένου για καθορισμένο κείμενο και 

κείμενο μονής γραμμής, τα κείμενα πολλαπλών γραμμών είναι διαθέσιμα. 

 
Μενού: Εισαγωγή εντολής: Express > Εργαλεία 

κειμένου > Αλλαγή στυλ κειμένου: CHGSTY 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε το κείμενο για να αλλάξετε το στυλ κειμένου και 

μπορείτε να τροποποιήσετε πολλά αντικείμενα ταυτόχρονα. Στη 

συνέχεια, πατήστε enter για να ολοκληρώσετε την εντολή. 

 

 

Κινέζικοι χαρακτήρες Split: επειδή η αγγλική λέξη είναι ένας συνδυασμός πολλών γραμμάτων. Αυτή η λειτουργία 

έχει νόημα μόνο για κινεζικούς χαρακτήρες. 

 
Μενού: Κινέζικοι χαρακτήρες Διαχωρισμός Εισαγωγή εντολών: HZCF 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε το κείμενο προς διαχωρισμό. 

3. Πατήστε enter για να ολοκληρώσετε τη διάσπαση. 
 

 

Διάλειμμα χαρακτήρων: Μενού: > Εργαλεία 

κειμένου > Διάλειμμα χαρακτήρων Εισαγωγή εντολών: 

WZDD Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 2. Επιλέξτε το κείμενο που θέλετε να σπάσετε. 3. Καθορίστε τη θέση του σπασίματος. 
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Αλλαγή χαρακτήρα: Αυτή η λειτουργία μπορεί να αναθεωρεί συνεχώς πολλαπλά αντικείμενα κειμένου, ισχύουν η 

μονή γραμμή και το Mtext. Μενού: Αλλαγή χαρακτήρα 

Είσοδος εντολών: _DDEDIT 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε το κείμενο προς αντικατάσταση. 

3. Εισάγετε χαρακτήρες προς αντικατάσταση και πατήστε Enter για να ολοκληρώσετε. 
 
 

 
Αλλάξτε έναν χαρακτήρα: Επιπλέον, μπορεί να χρησιμοποιηθεί σε πολλά κείμενα μονής γραμμής ταυτόχρονα. 

 
Μενού: Εισαγωγή εντολής: Express > Εργαλεία 

κειμένου > Αλλαγή ενός χαρακτήρα: CHGTXT 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε το κείμενο προς αντικατάσταση. 

3. Εισάγετε τους χαρακτήρες προς αντικατάσταση. 

4. Εισαγωγή χαρακτήρων προς αντικατάσταση. 

5. Πατήστε enter για να ολοκληρώσετε. 

 

 

Αλλαγή ύψους/πλάτους/γωνίας/θέσης κειμένου: Αυτή η λειτουργία χρησιμοποιείται για την τροποποίηση του 

ύψους του κειμένου, του πλάτους του κειμένου, της γωνίας του κειμένου και της θέσης του κειμένου. Μπορείτε να 

κάνετε κλικ ή να επιλέξετε χαρακτήρες από την επιλογή παραθύρου. 

 
Μενού: Εισαγωγή εντολών: TXTHEI / TXTWID / TXTANG / TXTPOS 

 
Διαγραφή σχολίων: μπορείτε απλά να πατήσετε enter και όλες οι σημειώσεις κειμένου θα διαγραφούν ή μπορείτε να 

επιλέξετε τα κείμενα με επιλογή παραθύρου και δεν θα επηρεάσει τα κείμενα άλλων στρωμάτων. 

 
Μενού: Εισαγωγή εντολής: Express > Εργαλεία 

κειμένου > Διαγραφή σχολιασμού: WZOFF 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε μια σημείωση κειμένου προς διαγραφή. Αυτή τη στιγμή καθορίζετε μόνο το επίπεδο λειτουργίας, αν 

πατήσετε απευθείας το πλήκτρο enter, θα διαγραφεί ολόκληρο το επίπεδο μεμονωμένων κειμένων. 

3. Επιλέξτε τα σχόλια που θέλετε να διαγράψετε (μπορείτε να επιλέξετε πολλά αντικείμενα με επιλογή παραθύρου) και πατήστε enter για να 
ολοκληρώσετε. 
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Προσαρμόστε τον χαρακτήρα: Όταν τα κείμενα αναμειγνύονται με κινεζικούς χαρακτήρες, αγγλικά γράμματα και 

αραβικούς αριθμούς, το ύψος του κειμένου θα είναι διαφορετικό και το οπτικό αποτέλεσμα δεν είναι καλό. Μπορείτε να 

χρησιμοποιήσετε αυτή τη λειτουργία για να ταιριάξετε το ύψος του κειμένου, αλλά αυτή η λειτουργία θα εκραγεί το 

κείμενο και θα είναι δύσκολο να το ξαναεπεξεργαστείτε, γι' αυτό προτείνουμε να χρησιμοποιήσετε αυτή τη 

λειτουργία αφού ο χρήστης ολοκληρώσει την επεξεργασία του σχεδίου. 

 
Μενού: Εισαγωγή εντολής: TTL2 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε το αντικείμενο κειμένου που πρέπει να προσαρμόσετε το ύψος. 

3. Πατήστε enter για να ολοκληρώσετε. 

 

 

 

 

3. Εργαλεία διάταξης 

 
Ευθυγράμμιση χώρου: Προσαρμόστε τον παράγοντα ζουμ και πανοραμικής μεγέθυνσης στο παράθυρο προβολής 

διάταξης με βάση τα σημεία ευθυγράμμισης που καθορίζονται στο χώρο μοντέλου και στο χώρο χαρτιού. 

Μενού: Εισαγωγή εντολής: Express > 

Εργαλεία διάταξης> Ευθυγράμμιση χώρου: 

ALIGNSPACE 

 

 
Κλίμακα προβολής λίστας: Εμφανίζει την κλίμακα του τρέχοντος παραθύρου προβολής ή ενός 

επιλεγμένου παραθύρου προβολής διάταξης. Μενού: Εργαλεία διάταξης> Κλίμακα προβολής 

λίστας 

Είσοδος εντολών: VPSCALE 

 
Συγχρονισμός θυρών προβολής: Συγχρονίστε ένα ή περισσότερα παράθυρα προβολής διάταξης με ένα κύριο παράθυρο 

προβολής διάταξης για να έχετε την ακριβή αντιστοίχιση των θέσεων. Όλα τα συγχρονισμένα παράθυρα προβολής 

χρησιμοποιούν τον παράγοντα ζουμ του κύριου παραθύρου προβολής. 

Μενού: Εισαγωγή εντολής: Express > Εργαλεία διάταξης> 

Συγχρονισμός θυρών προβολής: VPSYNC 

 
Συγχώνευση διατάξεων: Συγχωνεύει συγκεκριμένες διατάξεις σε μια ενιαία διάταξη. Όλες οι διατάξεις ή το μοντέλο 

είναι διαθέσιμα προς επιλογή και μπορείτε να καθορίσετε μια υπάρχουσα διάταξη ή να εισαγάγετε ένα νέο όνομα για 

να δημιουργήσετε μια νέα διάταξη ως διάταξη προορισμού. 

 
Μενού: Συγχώνευση Εντολή Εισαγωγή: 

Express > Εργαλεία διάταξης> Συγχώνευση 

διάταξης: LAYOUTMERGE 
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4. Εργαλεία διάστασης 
 

 
Τραπέζι περιοχής: Η εντολή AREATABLE διαστασιολογεί και μετρά αυτόματα το εμβαδόν ενός κλειστού αντικειμένου και 

εξάγει το αποτέλεσμα σε έναν πίνακα στην τρέχουσα περιοχή σχεδίασης. 

 
Μενού: Εισαγωγή εντολών: 

Express>Dimension>AreaTable: 

AREATABLE 

 
Η περικλειόμενη περιοχή ή το αντικείμενο μπορεί να επισημανθεί με έναν αριθμό ή ένα σύμβολο περιοχής, και τα 

δεδομένα του πίνακα περιοχής μπορούν να δημιουργηθούν ταυτόχρονα. Τα δεδομένα περιοχής μπορούν να εξαχθούν 

σε αρχείο κειμένου ή πίνακα. Οι τιμές στον πίνακα μπορούν να αλλάζουν αυτόματα όταν αλλάζει ο αριθμός ή το 

μέγεθος της περιοχής. 

 

 

 

Rapid Dist: Μέτρηση της απόστασης και της γωνίας μεταξύ 2D αντικειμένων κατά μήκος των αξόνων X, Y 

με ταχεία μετακίνηση του ποντικιού. Μενού: Express>Dimension> Rapid Dist 

Είσοδος εντολών: RAPIDDIST 

 
Οι αποστάσεις που μπορούν να μετρηθούν μόνο 

κατά μήκος των αξόνων Χ, Υ με βάση τη θέση του 

ποντικιού σας, εμφανίζονται δυναμικά καθώς 

μετακινείτε το ποντίκι σας πάνω και μεταξύ 

των αντικειμένων. Οι γωνίες μεταξύ των 

αντικειμένων που αγγίζουν οι γραμμές 

απόστασης, εμφανίζονται δυναμικά 
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ταυτόχρονα. 

Η εντολή μπορεί να χρησιμοποιηθεί μόνο στο 

πλαίσιο του WCS και μετράει μόνο τα 

αντικείμενα 2D. Και οι γωνίες των μπλοκ δεν 

μπορούν να μετρηθούν. 

 

 

 

Πληκτρολογήστε "Ρυθμίσεις", μπορείτε να ρυθμίσετε 

τη μετατροπή μονάδας και την κλίμακα στο παράθυρο 

ρυθμίσεων. 

Πληκτρολογήστε "Record", μπορείτε να αποθηκεύσετε το τρέχον 

αποτέλεσμα στο παράθυρο γραμμής εντολών, το οποίο είναι 

βολικό για να ελέγξετε ή να αντιγράψετε δεδομένα σε άλλα 

έγγραφα. 

 
 

 

Αλλαγή κειμένου διάστασης: Αλλαγή του περιεχομένου της διάστασης στην 

καθορισμένη τιμή. Μενού: Διάσταση>Αλλαγή κειμένου διάστασης 

Είσοδος εντολών: CHGDIMTXT 

 
Οι οδηγίες στη γραμμή εντολών έχουν ως εξής: 

-Επιλογή αντικειμένων διαστάσεων: Επιλέξτε μια διάσταση 

-Τρέχον περιεχόμενο ετικέτας <129.9>, εισαγωγή νέου κειμένου διάστασης 

<πρακτικά διάσταση μέτρησης>: Πληκτρολογήστε μια νέα τιμή (130) 
 
 
 
 

 
Αλλαγή Dimstyle: Εφαρμόζει το τρέχον στυλ 

διαστάσεων στις διαστάσεις του σχεδίου. 

 
Μενού: Εισαγωγή εντολής: 

Express>Dimension>Change Dimstyle: Dimstyle 
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Επαναφορά Dim Text Value: Επαναφορά μιας τιμής μέτρησης σε 

παρακαμπτόμενο ή τροποποιημένο κείμενο διάστασης. 

 
Μενού: Κείμενο: Express>Dimension>Reset Dim Text 

Value Εισαγωγή εντολής: 

Express>Dimension>Reset Dim Text Value: 

DIMREASSOC 

 
Οι οδηγίες στη γραμμή εντολών έχουν ως εξής: Επιλέξτε αντικείμενο: 

ή πατήστε ENTER για να τερματίσετε. 

 

 

 

Διάσταση ενημέρωσης: Ενημερώνει οποιαδήποτε άλλη διάσταση(ες) στο τρέχον στυλ διάστασης που 

θέλετε να εφαρμόσετε. Μενού: Διάσταση>Επικαιροποίηση διάστασης 

Είσοδος εντολών: DIMUPDATE 

 
Οι εντολές της γραμμής εντολών είναι οι εξής: 

-Επιλέξτε μια διάσταση για το πρότυπο: Επιλέξτε μια διάσταση ως βάση. 

-Επιλέξτε μια διάσταση, εξασφαλίστε την ενημέρωση του στυλ διάστασης: Επιλέξτε διάσταση(ες) προς ενημέρωση. 

 

 

Εξαγωγή Dimstyle: Εξάγει ονομαστικά στυλ διαστάσεων και τις ρυθμίσεις τους σε ένα 

εξωτερικό αρχείο. Μενού: Express>Dimension>Dimstyle Export 

Είσοδος εντολών: DIMEX 

 
Με την εκτέλεση αυτής της εντολής, εμφανίζεται το ακόλουθο παράθυρο διαλόγου: 

Όνομα αρχείου εξαγωγής: Δημιουργεί ένα αρχείο DIM. Εισάγετε το όνομα του αρχείου 

DIM ή επιλέξτε Αναζήτηση για να εντοπίσετε το αρχείο. Εάν το αρχείο δεν υπάρχει, 

δημιουργείται. Εάν το αρχείο υπάρχει, μια προτροπή ζητά άδεια αντικατάστασης. 

Το νέο αρχείο είναι ένα αρχείο ASCII. 

Διαθέσιμα στυλ διαστάσεων: Επιλέγει τα στυλ διαστάσεων για εγγραφή στο αρχείο ASCII. Το 
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εμφανίζονται τα τρέχοντα στυλ διαστάσεων. Κάθε επιλεγμένο στυλ εγγράφεται στο αρχείο που υποδεικνύεται στην ομάδα Export Filename 
(Όνομα αρχείου εξαγωγής). 

Επιλογές στυλ κειμένου: Αποθηκεύει στο αρχείο ASCII είτε τις 

πληροφορίες πλήρους στυλ κειμένου της διάστασης είτε μόνο 

το όνομα του στυλ κειμένου. 

 
Σημείωση: Τα Dimstyles δημιουργούνται και αποθηκεύονται με την 

εντολή DDIM. Πρέπει να επιλέξετε τουλάχιστον ένα Dimstyle για να 

είναι επιτυχής η εξαγωγή. 

 
 
 

 

Εισαγωγή Dimstyle: Εισάγει ονομαστικά στυλ διαστάσεων από ένα αρχείο DIM στο τρέχον 

σχέδιο. Μενού: Express>Διαστάσεις>Εισαγωγή στυλ διαστάσεων 

Είσοδος εντολών: DIMIM 

 
Με την εκτέλεση αυτής της εντολής, εμφανίζεται το ακόλουθο παράθυρο διαλόγου: 

 

 

Όνομα αρχείου εισαγωγής: Ονομάζει 

το αρχείο που θέλετε να εισαγάγετε. 

Εισάγετε ένα υπάρχον όνομα αρχείου 

ή επιλέξτε Αναζήτηση για να 

καθορίσετε ένα αρχείο DIM προς 

εισαγωγή. Το αρχείο πρέπει να έχει 

τη μορφή που παράγεται από την 

αντίστοιχη εντολή DIMEX. Όλα τα στυλ 

διαστάσεων στο επιλεγμένο αρχείο 

εισάγονται στο 

τρέχον σχέδιο. Εισάγονται επίσης στυλ κειμένου. 

 
Επιλογές εισαγωγής: για να διατηρήσετε το στυλ διάστασης στο τρέχον σχέδιο και Αντικατάσταση υπάρχοντος στυλ, 

για να αντικαταστήσετε τα στυλ στο τρέχον σχέδιο. Η επιλογή Keep the Existing Style (Διατήρηση του υπάρχοντος στυλ) 

αγνοεί το στυλ με παρόμοιο όνομα που εισάγεται- η επιλογή Overwrite Existing Style (Αντικατάσταση υπάρχοντος 

στυλ) χρησιμοποιεί το στυλ με παρόμοιο όνομα που εισάγεται. 

 

 
Επισυνάψτε τον Leader σε σχολιασμό: Προσαρμόστε την επικεφαλής γραμμή στο 

Mtext, την ανοχή ή το αντικείμενο αναφοράς μπλοκ. 

 
Μενού: Εισαγωγή εντολής: Express>Διάσταση>Συνδέστε 

τον αρχηγό σε σχολιασμό: QLATTACH 
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-Επιλογή αρχηγού: Επιλέξτε έναν ηγέτη 

-Επιλογή διάστασης: Επιλέξτε το αντικείμενο αναφοράς Mtext, ανοχής ή μπλοκ για το 

σχόλιο. 

 
Παράδειγμα χρήσης: 

-Επιλέξτε έναν αρχηγό και, στη συνέχεια, καθορίστε το αντικείμενο Mtext που θέλετε να επισυνάψετε. 

-Διαχωρίστε τα αντικείμενα leader line και Mtext. 

-Η γραμμή αρχηγού με το mtext επισυνάπτεται ως ένα αντικείμενο. 

 
Στην προτροπή Select Leader: (Επιλογή αρχηγού:), θα σας ζητηθεί να επιλέξετε ένα αντικείμενο αρχηγού ή να διακόψετε την εντολή. 

Στην προτροπή Select Annotation:, θα σας ζητηθεί να επιλέξετε ένα αντικείμενο MText, Tolerance ή Block Reference 

για το σχολιασμό. 

 

 
Αποσυνδέστε τους ηγέτες από το Annotation: Απόσπαση γραμμής αρχηγού από το αντικείμενο 

αναφοράς mtext, ανοχής ή μπλοκ. Μενού: Express>Dimension>Detach Leaders from Annotation

 Εισαγωγή εντολών: 

QLDETACHSET 

-Επιλογή αντικειμένων: Επιλογή γραμμής αρχηγού. 

 
Παράδειγμα χρήσης: 

-Επιλέξτε μια γραμμή αρχηγού για να αποσυνδεθείτε από ένα αντικείμενο mtext. 

 

 

Global Attach Leader to Annotation: Προσκολλάει συνολικά γραμμές αρχηγού σε αντικείμενα αναφοράς mtext, ανοχής ή μπλοκ. 

 
Μενού: Εισαγωγή εντολής: Express>Dimension>Global 

Attach Leader to Annotation: QLATTACHSET 

 
-Επιλογή αντικειμένων: Επιλέξτε μία ή περισσότερες γραμμές αρχηγού 

και αντικείμενα σχολιασμού. 

 
Παράδειγμα χρήσης: 

-Επιλογή γραμμής(ών) αρχηγού και αντικειμένων mtext για επισύναψη. 

-Επιλογή αντικειμένων: Επιλογή μιας ή περισσότερων γραμμών αρχηγού και σχολιασμού. 

αντικείμενα, η γραμμή εντολών ζητάει: Αριθμός ξεκλειδωμένων ηγετών = 2, Αριθμός με σχολιασμό αποσυνδεδεμένο = 2 

-Ηγέτης με αποσυνδεδεμένο αντικείμενο Mtext (Εικ. 5) 

-Οδηγός προσαρτημένος σε αντικείμενο μπλοκ (Σχήμα 6) 
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5. Ε ρ γ α λ ε ί α  επιλογής  

Λήψη σετ επιλογής: Δημιουργία ενός προσωρινού 

συνόλου επιλογής αντικειμένων. Μενού: 

Επιλογή>Παραλαβή συνόλου επιλογής 

Είσοδος εντολών: GETSEL 

 
-Επιλέξτε ένα αντικείμενο στο επίπεδο Source: ή πατήστε ENTER για όλες τις στρώσεις. 

-Επιλέξτε ένα αντικείμενο του τύπου που θέλετε: ή πατήστε ENTER για όλους τους τύπους αντικειμένων. 
 

 

Γρήγορη επιλογή: Επιλέγει το αντικείμενο που αγγίζει 

το συγκεκριμένο αντικείμενο. Μενού: Επιλογή> 

Γρήγορη επιλογή 

Είσοδος εντολών: FASTSEL 

 
Μπορείτε να εισαγάγετε την εντολή FASTSEL για να επιλέξετε αμέσως όλα τα αντικείμενα που αγγίζουν το επιλεγμένο αντικείμενο. 

 

 
Τα υποστηριζόμενα αντικείμενα περιλαμβάνουν: Γραμμές, πολυγραμμές, κύκλους, τόξα, ορισμούς 

χαρακτηριστικών, κείμενο, Mtext, ελλείψεις και εικόνες. FSMODE: Ελέγχει δύο συμπεριφορές της 

εντολής FASTSEL, η προεπιλεγμένη τιμή είναι OFF. 

Εάν το FSMODE είναι απενεργοποιημένο, όταν εκτελείτε την εντολή FASTSEL, επιλέγονται μόνο τα αντικείμενα 

που αγγίζουν το επιλεγμένο αντικείμενο. 

 
Εάν η εντολή FSMODE είναι ενεργοποιημένη, όταν εκτελείτε την εντολή FASTSEL, επιλέγονται όλα τα 

αντικείμενα που αγγίζουν το επιλεγμένο αντικείμενο, καθώς και όλα τα αντικείμενα που αγγίζουν αυτά τα 

αντικείμενα. Η διαδικασία επιλογής όλων των μη επιλεγμένων αντικειμένων που αγγίζουν συνεχίζεται μέχρι 

να μην υπάρχουν πλέον μη επιλεγμένα αντικείμενα ορατά στην περιοχή σχεδίασης. 
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Επιλογή φίλτρων Επιλογή, επεξεργασία και ονομασία φίλτρων 

για την επιλογή αντικειμένων. Μενού: Επιλογή φίλτρων 

Είσοδος εντολών: Φίλτρο 

 
Επιλέξτε το παράθυρο διαλόγου Φίλτρο αντικειμένου Επιλογές: 
 

1. X, Y, Z Παράμετροι: Ορίζει πρόσθετες παραμέτρους φίλτρου ανάλογα με το αντικείμενο. Στο φίλτρο 

παραμέτρους, μπορείτε να χρησιμοποιήσετε σχετικές τελεστές όπως < (μικρότερο από) ή > (μεγαλύτερο από). 

2. Επιλέξτε: Εμφανίζει ένα παράθυρο διαλόγου πλαίσιο που απαριθμεί όλα τα στοιχεία του καθορισμένος τύπος στο 

σχέδιο. Επιλέξτε τα στοιχεία που θέλετε να φιλτράρετε. 

3. Προσθήκη στη λίστα: Προσθέτει την τρέχουσα ιδιότητα Select Filter στη λίστα φίλτρων. Οι ιδιότητες φίλτρων που προσθέτετε 

στο ανώνυμο φίλτρο παραμένουν διαθέσιμες κατά τη διάρκεια της τρέχουσας συνεδρίας εργασίας, εκτός αν τις διαγράψετε 

μη αυτόματα. 

4. Αντικαταστήστε: Αντικαθιστά την ιδιότητα φίλτρου που έχει επιλεγεί στη λίστα ιδιοτήτων φίλτρου με αυτήν που 

εμφανίζεται στην επιλογή Επιλογή φίλτρου. 

5. Προσθήκη επιλεγμένου αντικειμένου: Προσθέτει ένα επιλεγμένο αντικείμενο στο σχέδιο στη λίστα φίλτρων. 

6. Επεξεργασία αντικειμένου: Μετακινεί το επιλεγμένο ιδιότητα φίλτρου στην περιοχή Επιλογή φίλτρου για 

επεξεργασία. Για να επεξεργαστείτε μια ιδιότητα φίλτρου, επιλέξτε την και επιλέξτε Edit Item (Επεξεργασία στοιχείου). 

Επεξεργαστείτε την ιδιότητα του φίλτρου και επιλέξτε Substitute (Αντικατάσταση). Το επεξεργασμένο φίλτρο αντικαθιστά 

την επιλεγμένη ιδιότητα φίλτρου. 

7. Διαγραφή: Διαγράφει μια επιλεγμένη ιδιότητα φίλτρου από το τρέχον φίλτρο. 

8. Clear List: Διαγράφει όλες τις καταχωρημένες ιδιότητες από το τρέχον φίλτρο. 

9. Χρησιμοποιείται το όνομα του φίλτρου: Εμφανίζει, αποθηκεύει και διαγράφει φίλτρα. 

10. Τρέχον: Εμφανίζει τα αποθηκευμένα φίλτρα. Επιλέξτε μια λίστα φίλτρων για να την κάνετε τρέχουσα. Το φίλτρο με το 

όνομα και η λίστα των οι ιδιότητες φορτώνονται από το προεπιλεγμένο αρχείο, filter.nfl 

11. Αποθήκευση ως: Αποθηκεύει ένα φίλτρο και τη λίστα ιδιοτήτων του. Το φίλτρο αποθηκεύεται στο αρχείο filter.nfl. 

Τα ονόματα μπορούν να περιέχουν έως και 18 χαρακτήρες. 

12. Διαγραφή τρέχουσας λίστας φίλτρων: Διαγράφει ένα φίλτρο και όλες τις ιδιότητές του από το προεπιλεγμένο αρχείο 

φίλτρων. 

13. Εφαρμόστε: Εξέρχεται από το παράθυρο διαλόγου και εμφανίζει την προτροπή Select Objects (Επιλογή αντικειμένων), 

όπου δημιουργείτε ένα σύνολο επιλογών. Το τρέχον φίλτρο χρησιμοποιείται στα αντικείμενα που επιλέγετε. 
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Λήψη επιλογής με βάση το όνομα μπλοκ: Μπορείτε να χρησιμοποιήσετε 

αυτή τη λειτουργία για να επιλέξετε πολλαπλά αντικείμενα με το ίδιο όνομα 

στην καθορισμένη περιοχή. 

 
Μενού: Εισαγωγή εντολής: Express>Εργαλεία Επιλογής>Παραλαβή 

Επιλογής με βάση το όνομα μπλοκ: GETBLKSEL 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε αντικείμενο, καθορίστε ένα όνομα μπλοκ για λειτουργία. 

3. Καθορίστε την περιοχή. 

4. Το σύστημα θα φέρει όλα τα μπλοκ με το ίδιο όνομα στην επιλεγμένη περιοχή στην επιλογή. 
 
 

 
Λήψη επιλογής ανά τύπο αντικειμένου: Μπορείτε να 

χρησιμοποιήσετε αυτή τη λειτουργία για να επιλέξετε 

πολλαπλά αντικείμενα με τον ίδιο τύπο οντότητας στην 

καθορισμένη περιοχή. 

 
Μενού: Εισαγωγή εντολής: Express>Εργαλεία Επιλογής>Παραλαβή 

Επιλογής ανά Τύπο Αντικειμένου: GETENTSEL 

Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε αντικείμενο και το σύστημα θα λάβει τον 

καθορισμένο τύπο οντότητας ως τύπο στόχου. Στη συνέχεια, 

καθορίστε την περιοχή. 

3. Το σύστημα θα φέρει στην επιλογή όλα τα μπλοκ με τον ίδιο 

τύπο οντότητας στην επιλεγμένη περιοχή της περιοχής. 

Λήψη επιλογής ανά στρώμα: Μπορείτε να χρησιμοποιήσετε αυτή τη λειτουργία για να επιλέξετε όλα τα αντικείμενα 

σε καθορισμένο επίπεδο και καθορισμένη περιοχή ταυτόχρονα. 

 
Μενού: Επιλογή ανά στρώμα Εισαγωγή εντολής: 

Express>Εργαλεία Επιλογής>Παραλαβή Επιλογής ανά 

στρώμα: GETLAYSEL 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε μια οντότητα που βρίσκεται στο στρώμα-στόχο και, στη συνέχεια, 

 καθορίστε την περιοχή. 

3. Το σύστημα θα επιλέξει όλα τα αντικείμενα στο καθορισμένο 

επίπεδο και στην καθορισμένη περιοχή. 
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Λήψη επιλογής ανά χρώμα: Γρήγορη επιλογή των αντικειμένων με το 

ίδιο χρώμα. Μενού: Επιλογή με βάση το χρώμα 

Είσοδος εντολών: Βήματα 

λειτουργίας: GETCOLSEL: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε ένα αντικείμενο και το σύστημα θα λάβει το χρώμα του αντικειμένου ως χρώμα-στόχο. 

3. Καθορίστε την περιοχή. 

4. Το σύστημα θα επιλέξει αυτόματα τα αντικείμενα που έχουν το ίδιο χρώμα με το 

αντικείμενο-στόχο. Λήψη επιλογής ανά αντικείμενο/στρώμα: Επιλογή οντοτήτων με βάση 

τον τύπο οντότητας και το στρώμα. 

Μενού: Επιλογή ανά αντικείμενο/στρώμα Εισαγωγή εντολής: 

Express>Εργαλεία Επιλογής>Παραλαβή Επιλογής ανά 

αντικείμενο/στρώμα: GETENTLAYSEL 

Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε ένα αντικείμενο και το σύστημα θα λάβει το επίπεδο του αντικειμένου ως επίπεδο-στόχο. 

3. Καθορίστε την περιοχή. 

4. Το σύστημα θα επιλέξει αυτόματα τα αντικείμενα που βρίσκονται στο ίδιο επίπεδο και με τον ίδιο τύπο οντότητας. 
 

 
Λήψη επιλογής με βάση το αντικείμενο/χρώμα: Επιλέξτε οντότητες με 

βάση τον τύπο οντότητας και το χρώμα. Μενού: Express>Εργαλεία 

Επιλογής>Παραλαβή Επιλογής με βάση το αντικείμενο/χρώμα: 

GETENTCOLSEL 

Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε ένα αντικείμενο και το σύστημα θα λάβει το χρώμα του αντικειμένου ως χρώμα-στόχο. 

3. Καθορίστε την περιοχή. 

4. Το σύστημα θα επιλέξει αυτόματα τα αντικείμενα που έχουν τον ίδιο τύπο οντότητας και το ίδιο χρώμα με το αντικείμενο-στόχο. 

 

 

Λήψη επιλογής με βάση το στρώμα/χρώμα: Επιλέξτε οντότητες 

με βάση το χρώμα και το στρώμα. Μενού: Express>Εργαλεία 

Επιλογής>Παραλαβή Επιλογής με βάση το στρώμα/χρώμα: 

GETLAYCOLSEL 

Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε μια οντότητα που βρίσκεται στο επίπεδο-στόχο. 

3. Καθορίστε την περιοχή. 

4. Το σύστημα θα επιλέξει αυτόματα τα αντικείμενα που έχουν το ίδιο χρώμα και το ίδιο στρώμα με το αντικείμενο-στόχο. 
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6. Τροποποίηση εργαλείων 

 
Στρώμα Draworder: Επανακαθορίζει τη σειρά των στρώσεων 

για να προσαρμόσει τη σειρά των αντικειμένων. 

 
Μενού: Εισαγωγή εντολής: 

Express>Modify> Layer Draworder: 

LAYDRAWORDER 

 
 
 

 

Draworder by Color: Τακτοποιεί τη σειρά σχεδίασης των επιλεγμένων αντικειμένων με βάση τον 

αριθμό χρώματος. Μενού: Χρώμα: Express>Μόρφωση> Σειρά σχεδίασης με βάση το 

χρώμα 

Είσοδος εντολών: CDORDER 

 
Σπάστε το αντικείμενο: Σε ορισμένες βιομηχανικές 

εφαρμογές σχεδιασμού, μερικές φορές χρειάζεται να 

σπάσουμε σωλήνες ή γραμμές καλωδίων στο 

σχηματικό μας σχέδιο για να δείξουμε τη χωρική τους 

σχέση. Μερικές φορές χρειάζεται επίσης να σπάσουμε 

τις γραμμές στο σημείο διασταύρωσης για να το 

κάνουμε βολικό για την μετέπειτα επεξεργασία. Το 

εργαλείο Break Object προήλθε από αυτού του είδους 

τις ανάγκες. 

 
Μενού: Εργαλεία 

Εξπρές>Τροποποίηση>Σπάσιμο 

αντικειμένου Εισαγωγή εντολής: Express 

tools>Modify>Break Object: BREAKOBJECT 
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Αυτό το εργαλείο παρέχει τέσσερις τρόπους θραύσης με απόσταση διακένου για την απεικόνιση των διαφορών μεταξύ των επιλογών θραύσης. 

 
Διάκενο: Δείχνει την τιμή του διακένου μεταξύ των σπασμένων αντικειμένων. 

Σπάστε όλα τα επιλεγμένα αντικείμενα μεταξύ τους: Αυτή η επιλογή σπάει όλα τα αντικείμενα που τέμνονται μεταξύ 

τους. Μπορείτε να επιλέξετε αντικείμενα με επιλογή παραθύρου ή επιλέγοντας κάθε αντικείμενο. 

Σπάστε επιλεγμένα αντικείμενα με άλλα 

επιλεγμένα αντικείμενα: Αυτή η επιλογή σπάει 

όλα τα τεμνόμενα αντικείμενα με δύο σύνολα 

επιλογής (Α και Β). Τα αντικείμενα που 

έχουν επιλεγεί με το πρώτο σύνολο (Α) θα 

σπάσουν εν τω μεταξύ τα αντικείμενα που 

έχουν επιλεγεί με το δεύτερο σύνολο (Β) δεν 

θα σπάσουν. 

Σπάστε αντικείμενα που αγγίζουν 

επιλεγμένα αντικείμενα: Αυτή η επιλογή 

σπάει όλα τα διασταυρούμενα αντικείμενα 

που αγγίζουν σε πρώτη φάση το επιλεγμένο 

αντικείμενο. 

Σπάει τα επιλεγμένα αντικείμενα με όλα τα 

αντικείμενα που το αγγίζουν: Αυτή η επιλογή 

σπάει το πρώτο επιλεγμένο αντικείμενο με 

όλα τα αντικείμενα που το τέμνουν. 
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Μετακίνηση/Αντιγραφή/Περιστροφή: Μετακίνηση, αντιγραφή, περιστροφή και κλιμάκωση αντικειμένων με μία μόνο εντολή. 

 
Μενού: Μετακίνηση/Αντιγραφή/Περιστροφή 

Εισαγωγή εντολής: Εργαλεία 

Express>Μεταβολή>Μετακίνηση/Αντιγραφή/Περιστρ

οφή: MOCORO 

 
Οι εντολές της γραμμής εντολών είναι οι εξής: Επιλέξτε αντικείμενα: Επιλέξτε αντικείμενο(α) και πατήστε Enter 

Σημείο βάσης: Καθορίστε ένα σημείο βάσης 

[Μετακίνηση/Αντιγραφή/Περιστροφή/Κλίμακα/Βάση/Αναίρεση]<eXit>: Μόλις καθοριστεί μια επιλογή 

 

 
 

 
Επιλογές  
Μετακίνηση: Μετακίνηση αντικείμενο(α).  
Αντιγραφή: Δημιουργία πολλαπλών αντιγράφων αντικειμένου(-ων).  
Περιστροφή: Περιστροφή αντικειμένου(-ων).  
Κλίμακα: Δυναμική κλιμάκωση αντικειμένου(-ων).  
Βάση: Καθορίζει ένα σημείο βάσης για το(α) αντικείμενο(α) που πρόκειται να μετακινηθεί(-ούν), να αντιγραφεί(-ούν), να 
κλιμακωθεί(-ούν) ή να περιστραφεί(-ούν). 

Κλίμακα περιοχής: Μπορείτε να επιλέξετε μια περιοχή ενός σχεδίου που θα αποκοπεί και θα 

αντιγραφεί σε μια νέα θέση. Μενού: Κλίμακα περιοχής 

Είσοδος εντολών: _REGSCALE 

 
Οι εντολές της γραμμής εντολών είναι οι εξής: 

Καθορίστε το σημείο της αριστερής επάνω γωνίας για ολοσέλιδη 

απόδειξη: Επιλέξτε μια περιοχή από την αριστερή επάνω προς τη δεξιά 

κάτω γωνία 
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Καθορίστε τη θέση για αντιγραφή: Καθορίστε οποιαδήποτε θέση θέλετε να αντιγράψετε στην επιλεγμένη περιοχή. 

 

 

 

 

 

 

 

 
Επιλέξτε το αντικείμενο προς περικοπή ή επιλέξτε με shift-select την επιλογή Extend ή [Edge/Fence/Crossing/Project]: 

Επιλέξτε τα αντικείμενα προς περικοπή ή πατήστε Enter για να ολοκληρώσετε τη λειτουργία. 
 
 
 
 

 
Εισαγωγή κλιμάκωσης ζουμ, το μπλοκ και το κείμενο θα μεγεθυνθούν μαζί <Enter- No 

Zoom>: Πατήστε Enter για να ολοκληρώσετε τη λειτουργία. 

 
 
 

 
Βελτίωση περιποίησης: Περικοπή μιας πλευράς ενός αντικειμένου που τέμνεται με άλλα αντικείμενα. Το 

αντικείμενο μπορεί να είναι πολυγραμμή, γραμμή, κύκλος, τόξο, έλλειψη, εικόνα ή κείμενο. 

 
Μενού: Εντολή Εισαγωγή: Express 

tools>Modify>Trim Enhancement: EXTRIM 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε ένα αντικείμενο ως αναφορά περιποίησης, εδώ επιλέγουμε το ορθογώνιο για παράδειγμα. 

3. Καθορίστε την πλευρά στην οποία θα γίνει η περικοπή. 

4. Εδώ επιλέγουμε το εσωτερικό σημείο του ορθογωνίου, θα δείτε ότι οι εσωτερικές γραμμές του ορθογωνίου κόβονται. 
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Διευρυμένη μετατόπιση: Αυτή η βελτιωμένη έκδοση της εντολής OFFSET προσφέρει πολλά πλεονεκτήματα σε σχέση με 

την τυπική εντολή, όπως έλεγχο στρώματος, αναίρεση και επιλογή πολλαπλών. 

 
Μενού: Εισαγωγή εντολής: Express 

tools>Modify>Extended Offset: EXOFFSET 

 
1 .Καθορίστε την απόσταση μετατόπισης ή [Through] <T>: Καθορίστε την απόσταση μετατόπισης ή το σημείο διέλευσης 

2 .Επιλέξτε αντικείμενο(α) για αντιστάθμιση ή [Επιλογές/Αναίρεση]: Επιλέξτε ένα αντικείμενο για αντιστάθμιση, αλλαγή επιλογών ή αναίρεση 

3 .Καθορίστε μια επιλογή για να ορίσετε [Απόσταση/στρώμα/τύπος διακένου]: Καθορίστε μια επιλογή 



31 
 

EXOFFSET Επιλογές: 

Απόσταση: Καθορίστε την απόσταση μετατόπισης ή το σημείο διέλευσης 

Στρώμα: Καθορίστε το επίπεδο για τα νέα αντικείμενα. Τρέχον στρώμα ή Στρώμα πηγαίου αντικειμένου 

GapType: Ορίζει ή αλλάζει τον τρόπο μετατόπισης, όπως ελέγχεται από τη μεταβλητή OFFSETGAPTYPE. Οι επιλογές 

είναι οι εξής: Οι επιλογές είναι: Normal, Fillet ή Chamfer. 

  

Απόσταση Στρώμα GapType 
 
 

 

Multiple Pedit: Αυτή η εντολή είναι σχεδόν η ίδια με την τυπική εντολή. Μενού: 

Πολλαπλά Pedit: Express tools>Modify>Multiple Pedit 

Είσοδος εντολών: MPEDIT 

 
1. Ξεκινήστε την εντολή. 

2. Επιλέξτε αντικείμενο 

3. Καθορίστε μια επιλογή για να ορίσετε [Open/Close/Decurve/Fit/Linetype-mode/Spline/Width/eXit]<eXit>: 

 
Παράδειγμα για το κλείσιμο των plines: 

1. Επιλογή αντικειμένου: επιλέξτε τις γραμμές που θέλετε να κλείσετε. 
 

 
2. [Open/Close/Decurve/Fit/Linetype-mode/Spline/Width/eXit]<eXit>: Εισάγετε τη λέξη-κλειδί: C και πληκτρολογήστε. 

3. Θα κλείσουν οι γραμμές. 
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Διαγραφή διπλών αντικειμένων : Αυτή η λειτουργία δεν μπορεί μόνο να διαχειριστεί επικαλυπτόμενες γραμμές, 

κύκλους, γραμμικά αντικείμενα Plines κλπ, αλλά μπορεί επίσης να διαχειριστεί ολόκληρα συμπίπτοντα μπλοκ, κείμενα, 

διαστάσεις και περιοχές .Επιπλέον, η αφαίρεση δεν σημαίνει απλά διαγραφή, κρίνει με βάση το στρώμα, το χρώμα, τον 

τύπο γραμμής και πολλά σχετικά χαρακτηριστικά και μπορεί να διαγράψει ή να συνδέσει συμπίπτοντα τμήματα 2D 

και 3D Plines, κύκλους, τόξα και επικαλυπτόμενα τμήματα γραμμής. Η χρήση αυτής της επιλογής μπορεί όχι μόνο 

να διαγράψει περιττά αντικείμενα, αλλά μπορεί επίσης να αποφύγει προβλήματα επεξεργασίας και εκτύπωσης 

που προκαλούνται από επικαλυπτόμενα αντικείμενα. 

 
Μενού: Εισαγωγή εντολής: Express tools > Modify > Delete 

Duplicate Objects (Διαγραφή διπλότυπων αντικειμένων): 

OVERKILL 

 
Ξεκινήστε την εντολή και η γραμμή εντολών εμφανίζεται ως εξής: Επιλέξτε αντικείμενα: Επιλέξτε τα αντικείμενα προς 

σύγκριση και διαγραφή. 

Στο παράθυρο διαλόγου overkill, μπορείτε να ρυθμίσετε τη σύγκριση αντικειμένων, την ακρίβεια σύγκρισης 

(απόσταση μεταξύ αντικειμένων) και τον τύπο αντικειμένου. Αφού επιλέξετε τις επιλογές ανάλογα με τις ανάγκες 

σας, επιλέξτε OK. 

 
 
 
 
 
 
 
 
 
 

 

Πολλαπλό αντίγραφο: Αντιγραφή πολλαπλών αντικειμένων με επιλογές επανάληψης, 

συστοιχίας, διαίρεσης και μέτρησης. Μενού: Πολλαπλή αντιγραφή 

Είσοδος εντολών: COPYM 
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Ξεκινήστε την εντολή και η γραμμή εντολών εμφανίζεται ως εξής: Επιλέξτε αντικείμενα: Επιλέξτε τα αντικείμενα που πρόκειται να 
αντιγραφούν. 

Σημείο βάσης: Καθορίστε ένα σημείο βάσης 

Δεύτερο σημείο ή [Επανάληψη (τελευταία)/Διαίρεση/Μέτρηση/Συστοιχία (δυναμική)/Αναίρεση] <εξοδος>: 

Επιλέξτε ένα δεύτερο σημείο ή οποιαδήποτε επιλογή Επιλογές: 

Επανάληψη: Επαναλάβετε το τελευταίο αντίγραφο χρησιμοποιώντας την ίδια απόσταση μετατόπισης. 

Διαχωρίστε: Γραμμική επιλογή διαίρεσης. Ζητάει ένα πρόσθετο σημείο και τον αριθμό των αντιγράφων που πρέπει να 

γίνουν. Δημιουργεί ομοιόμορφα αντίγραφα των επιλεγμένων αντικειμένων μεταξύ του σημείου βάσης και του 

δεύτερου επιλεγμένου σημείου 

 

 
 
 
 
 
 
 
 

Επανάληψη Διαίρεση 
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Μέτρο: Μέτρο: Επιλογή γραμμικού μέτρου. Ζητάει ένα πρόσθετο σημείο και την απόσταση μεταξύ των αντιγράφων. 

Δημιουργεί αντίγραφα με ομοιόμορφη απόσταση μεταξύ του βασικού σημείου και του δεύτερου επιλεγμένου 

σημείου στην καθορισμένη απόσταση. 

Συστοιχία: Εμφανίζει την προτροπή Array Options (Επιλογές συστοιχίας). 

 

Μέτρο Συστοιχία 

 
Διάταξη από τη διαδρομή: Διανομή αντιγράφων αντικειμένων κατά μήκος μιας διαδρομής (καμπύλης) με μια 

π ο ι κ ι λ ί α  επιλογών συστοιχίας. Οι χρήστες μπορούν να επιλέξουν επιλογές ra8ndom, διαίρεσης και 

μέτρησης και συστοιχία σε διαφορετικές κατευθύνσεις κατά μήκος της διαδρομής. 

Μενού: Διαμόρφωση με βάση τη διαδρομή Εισαγωγή εντολών: Για 

παράδειγμα, στο σχέδιο χαρτογράφησης, μπορούμε να εφαρμόσουμε το εξής 

εργαλείο για τη διάταξη του ασυνεχούς κεντρικού 

άξονα του δρόμου ή του αυτοκινητόδρομου, 

όπως φαίνεται στην εικόνα: 

 
 

 
Αφού εκκινήσετε την εντολή Layoutbypath, θα 

εμφανιστεί ένα μήνυμα στη γραμμή 

εντολών>Παρακαλούμε επιλέξτε το αντικείμενο 

που θέλετε να συστοιχίσετε: 

 

 
Αφού επιλέξετε το αντικείμενο, θα εμφανιστεί ένα μήνυμα προτροπής: 

Καθορίστε το σημείο βάσης: 

Το σημείο βάσης είναι το σημείο στο οποίο θέλετε να 

ξεκινήσετε να κάνετε συστοιχία από το αντικείμενο. 

Μπορούμε να επιλέξουμε το χαμηλό αριστερό τελικό 

σημείο αυτού του αντικειμένου: 

 

 
Αφού επιλέξετε το σημείο βάσης του αντικειμένου, θα εμφανιστεί ένα μήνυμα προτροπής: 



35 
 

Καθορίστε την κατεύθυνση του αντικειμένου κατά μήκος της καμπύλης<άξονας Υ του WCS>: 

Αυτό το μήνυμα είναι σημαντικό, επειδή αυτό θα επηρεάσει την κατεύθυνση 

του αντικειμένου κατά μήκος της διαδρομής. Επειδή επιλέγουμε το τελικό 

χαμηλό σημείο του αντικειμένου ως σημείο βάσης, πρέπει να καθορίσουμε μια 

κατεύθυνση παράλληλου σημείου για να διατηρήσουμε το αντικείμενο 

παράλληλο κατά μήκος της 

διαδρομή (μακριά πράσινη γραμμή): 

 
Αφού καθορίσετε την κατεύθυνση του αντικειμένου, θα 

εμφανιστεί ένα μήνυμα προτροπής: 

Επιλέξτε την καμπύλη: 

Στη συνέχεια, επιλέξτε τη μακριά πράσινη γραμμή. Αυτή η 

γραμμή είναι η καμπύλη ή η διαδρομή που θα 

ακολουθήσει το αντικείμενο. 

Αφού επιλέξετε την καμπύλη ή τη διαδρομή, θα εμφανιστεί ένα μήνυμα προτροπής: 

Καθορίστε επιλέξτε κατά μήκος ποιας πλευράς της 

καμπύλης <αριστερή πλευρά ή εμπρός 

κατεύθυνση>: Αυτό 

μήνυμα είναι επίσης σημαντικό επειδή θα καθορίσουμε 

την πλευρά που θα είναι η συστοιχία του αντικειμένου. 

Για παράδειγμα, καθορίζουμε την αριστερή πλευρά της 

καμπύλης όπως φαίνεται στην εικόνα. 

 
Αφού καθορίσετε την πλευρά της καμπύλης, θα εμφανιστεί ένα μήνυμα προτροπής: Επιλογή της μεθόδου Τυχαία (R) / 

Διαίρεση (F) / Μέτρηση (D): 

 
Υπάρχουν τρεις επιλογές τυχαία, διαίρεση και μέτρηση: 

 
Τυχαία: Αυτό επιτρέπει τη διάταξη του επιλεγμένου αντικειμένου κατά μήκος της διαδρομής σε ένα 

συγκεκριμένο σημείο σύμφωνα με τις ανάγκες του χρήστη. Διαίρεση: Αυτό επιτρέπει την αυτόματη διάταξη του 

επιλεγμένου αντικειμένου κατά μήκος της διαδρομής με την εισαγωγή του αριθμού των αντικειμένων. Μέτρηση: Αυτό 

επιτρέπει την αυτόματη διάταξη του επιλεγμένου αντικειμένου κατά μήκος της διαδρομής με την εισαγωγή της 

τιμής της απόστασης. 

 
Για παράδειγμα, αν δεν γνωρίζουμε την απόσταση μεταξύ των αντικειμένων αλλά γνωρίζουμε την ποσότητα των 

αντικειμένων, μπορούμε να επιλέξουμε την επιλογή Διαίρεση: 

 
Αφού επιλέξετε την επιλογή, θα εμφανιστεί ένα 

μήνυμα προτροπής: 

Πληκτρολογήστε τον αριθμό: Και εισάγουμε την τιμή 11 

 
Αφού εισαγάγετε την τιμή, θα εμφανιστεί ένα 

μήνυμα προτροπής: (Διανομή από την τελική 
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καμπύλη όταν η επιλογή είναι κενή): 

Στη συνέχεια, επιλέξτε ένα από τα τελικά σημεία της καμπύλης: 

 
Αφού επιλέξετε το σημείο της καμπύλης, θα λάβετε 

ακριβές αποτέλεσμα: Και επίσης μπορείτε να επαναλάβετε 

την ίδια επιλογή συστοιχίας για τον άλλο μπλε κεντρικό 

άξονα του δρόμου. 

 
Ισοπέδωση αντικειμένων: Μετατρέπει τρισδιάστατη γεωμετρία σε 

προβαλλόμενη αναπαράσταση 2D. Μενού: Αντικείμενα: 

Express>Modify> Flatten Objects Εισαγωγή εντολής: 

Flatten 
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7. Εργαλεία σχεδίασης 

Superhatch: Γεμίζει μια κλειστή περιοχή ή επιλεγμένα αντικείμενα με ένα μοτίβο 

κατωφλίου, στερεό γέμισμα ή κατωφλίωση διαβάθμισης. Μενού: 

Express>Draw>Superhatch 

Είσοδος εντολών: Superhatch 

 
Εμφανίζεται το παράθυρο διαλόγου Superhatch: 

 
Εικόνα: Πρόσβαση στο παράθυρο διαλόγου Επιλογή εικόνας για να 

καθορίσετε την εικόνα για το μοτίβο οριζοντιογραφίας.

 Μπλοκ

: Ανοίγει το παράθυρο 

Παράθυρο διαλόγου Superhatch_Insert για να καθορίσετε το μπλοκ για το μοτίβο οριζοντιογραφίας. 

Xref Attach: Πρόσβαση στο παράθυρο διαλόγου Select reference file 

(Επιλογή αρχείου αναφοράς) για τον καθορισμό ενός αρχείου xref για ένα 

μοτίβο οριζοντιογραφίας. 

WipeOut: Επιλέγει ένα αντικείμενο wipeout ως μοτίβο οριζοντιογραφίας. 

Επιλέξτε Υπάρχον: Επιλέγει μια υπάρχουσα εικόνα, μπλοκ, xref ή Wipeout 

ως μοτίβο χάραξης. Για εικόνες: 

1. Ανοίξτε το παράθυρο διαλόγου Superhatch. 

2. Κάντε κλικ στο κουμπί Image..., 

επιλέξτε ένα αρχείο εικόνας, 

εμφανίζεται το παράθυρο 

διαλόγου Superhatch Imageraster. 

3. Επιλέξτε το κουμπί OK στο 

παράθυρο διαλόγου Superhatch 

Imageraster, καθορίστε το σημείο 

εισαγωγής, τον συντελεστή 

κλίμακας και τη γωνία 

περιστροφής. 

4. Η ερώτηση "Είναι αποδεκτή η 

τοποθέτηση αυτής της ΕΙΚΟΝΑΣ; 

[Ναι/Όχι]<ναι>": 

5. Επιλέξτε ένα σημείο στο 

ορθογώνιο και πατήστε ENTER για 

να ολοκληρώσετε. 
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Για μπλοκ: 

 
1. Ανοίξτε το παράθυρο διαλόγου Superhatch. 

2. Κάντε κλικ στο κουμπί 

Block... για να αποκτήσετε 

πρόσβαση στο παράθυρο 

διαλόγου 

Superhatch_Insert: 

Μπλοκ: Κάντε κλικ στο κουμπί 

Μπλοκ... για να επιλέξετε ένα μπλοκ 

στο τρέχον αρχείο. 

Αρχείο: Επιλέξτε το κουμπί Αρχείο... για να επιλέξετε ένα αρχείο σχεδίασης ως μπλοκ. 

3. Επιλέξτε το μπλοκ στο πλαίσιο διαλόγου 

Defined Blocks και πατήστε OK. 

4. Καθορίστε το σημείο εισαγωγής, τον 

συντελεστή κλίμακας και τη γωνία 

περιστροφής. 

5. Η ερώτηση "Είναι αποδεκτή η τοποθέτηση 

αυτής της ΕΙΚΟΝΑΣ; 

[Ναι/Όχι]<ναι>"εμφανίζεται. Επιλέξτε No 

για Esc. Εάν 

επιλέξετε Ναι, το GstarCAD θα σας ζητήσει να καθορίσετε το πρώτο και το επόμενο σημείο για την τοποθέτηση της εικόνας. 

6. Καθορίστε ένα εσωτερικό σημείο των αντικειμένων για το όριο της χάραξης και, στη συνέχεια, πατήστε ENTER για να 
ολοκληρώσετε την χάραξη. 

 
Για το WipeOut: 

1. Αποκτήστε πρόσβαση 

στο παράθυρο διαλόγου 

Superhatch και κάντε κλικ 

στο κουμπί Wipeout: 

2. Το GstarCAD θα σας 

ζητήσει να καθορίσετε το 

σημείο εισαγωγής για να 

δημιουργήσετε μια 

περιοχή που καλύπτει τα 

υποκείμενα 

αντικείμενα 
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3. Πατήστε ENTER για να 

ολοκληρώσετε τη 

δημιουργία του ορίου που 

καλύπτει τα υποκείμενα 

αντικείμενα. 

4. Όπως φαίνεται στην εικόνα, μετακινήστε το νέο μπλοκ στο χαλί, το μπλοκ θα 

καλύψει αυτόματα το αντικείμενο κάτω από αυτό: 

 

 

 
Σύμβολο διαχωριστικής γραμμής: Δημιουργεί μια πολυγραμμή και εισάγει το σύμβολο της διαχωριστικής 

γραμμής. Οι επιλογές σε αυτή την εντολή παρέχονται για τον έλεγχο του σχετικού μεγέθους και της εμφάνισης 

του συμβόλου της διαχωριστικής γραμμής και της επέκτασης της πολυγραμμής πέρα από τα επιλεγμένα σημεία 

έναρξης και λήξης. 

 
Μενού: Εισαγωγή εντολών: Express 

tools>Draw>Breakline Symbol: 

BREAKLINE 

 
Μόλις ξεκινήσετε την εντολή, η γραμμή εντολών εμφανίζει τις ακόλουθες οδηγίες: 

 
Block = BRKLINE.DWG, Μέγεθος = 1.000, 

Επέκταση = 1.250 . Καθορίστε το πρώτο σημείο για τη 

γραμμή θραύσης ή [Block/Size/Extension/sPecify line for 

breakline]: Καθορίστε ένα σημείο ή εισάγετε επιλογές 

 
Επιλογές: 

 
Καθορίστε το πρώτο σημείο για τη γραμμή διακοπής: 

Σχεδιάζει γραμμή διακοπής μέσω του καθορισμού του 

σημείου έναρξης και του σημείου λήξης της. 

 
 

 
Μπλοκ: Καθορίζει το μπλοκ που θα χρησιμοποιηθεί ως 

σύμβολο γραμμής διαχωρισμού. Εισάγετε το όνομα 

του μπλοκ για το σύμβολο γραμμής θραύσης 

<BRKLINE.DWG>: Εισάγετε ένα όνομα μπλοκ και 

πατήστε ENTER ή πατήστε ENTER. Εάν πατήσετε 

απευθείας ENTER, η διαδρομή αποθήκευσης του 
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αρχείου του συμβόλου διακοπής θα είναι 

εμφανίζεται στη γραμμή εντολών. 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
Μέγεθος: Καθορίζει το μέγεθος του συμβόλου της διαχωριστικής γραμμής. 

Μέγεθος συμβόλου διακεκομμένης γραμμής <1>: Καθορίστε το μέγεθος του συμβόλου της διαχωριστικής γραμμής 

 
Επέκταση: Καθορίζει το μήκος της επέκτασης της γραμμής πέρα 

από τα επιλεγμένα σημεία. 

Απόσταση επέκτασης γραμμής θραύσης <1.25>: Καθορίστε 

την απόσταση επέκτασης. Αφού εκχωρηθεί το σημείο 

έναρξης για τη γραμμή διαχωρισμού ή το σύμβολο 

διαχωρισμού ρύθμισης, η γραμμή εντολών εμφανίζει τις 

ακόλουθες προτροπές: 

Καθορίστε το δεύτερο σημείο για τη γραμμή διακοπής: Καθορίστε ένα σημείο 

 
Καθορίστε τη θέση για το σύμβολο διακοπής <Midpoint>: Καθορίστε το σημείο στο 

τμήμα γραμμής για να καθορίσετε τη θέση του συμβόλου της γραμμής διακοπής ή πατήστε ENTER 

για να χρησιμοποιήσετε το μέσο της γραμμής. Spline to Line: Μετατρέπει το/τα spline(s) σε 

αριθμούς ευθειών γραμμών. 

Μενού: Εργαλεία 

Express>Σχέδιο> Spline to Line 

Εισαγωγή εντολής: SPLINE2LINE 

 
Μόλις ξεκινήσει η εντολή, η γραμμή εντολών εμφανίζει τις ακόλουθες προτροπές: 

Επιλέξτε spline ή [Ορισμός παραμέτρων(S)]: ή εισαγωγή "S" για να ορίσετε τις παραμέτρους 

[Η ακρίβεια της γραμμής/Το σημείο εκκίνησης (S)<1.00>]: Εισάγετε μια νέα τιμή μεγαλύτερη από 0 για να 

ενώσετε την ακρίβεια μεταξύ των γραμμών τμημάτων Μετατροπή σε ευθεία γραμμή για να επιτρέψετε το 

μεγαλύτερο αριθμό <5000>]: Εισάγετε μια νέα τιμή μικρότερη από 5000 για τον αριθμό των γραμμών 
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Αρχικά, το σύστημα θα προσαρμόσει τη spline με μια γραμμή τμήματος της οποίας η ακρίβεια (Length) 

έχει καθοριστεί, εάν ο αριθμός της γραμμής που απαιτείται είναι μεγαλύτερος από τον μέγιστο αριθμό, το 

σύστημα θα επεκτείνει το μήκος των γραμμών με τη βία, χρησιμοποιώντας τον μέγιστο αριθμό γραμμών για 

να προσαρμόσει τη spline. 

Επιλέξτε spline ή [Ορισμός παραμέτρων(S)]: Στη συνέχεια, επιλέξτε την/τις spline(s) προς μετατροπή και πατήστε Enter 
 για να ολοκληρώσετε τη λειτουργία 

 

 

 

 
Από Spline σε Pline: με αυτό το εργαλείο το SPline που δημιουργείται μπορεί να μετατραπεί σε 

πολυγραμμή σύμφωνα με την ακρίβεια (αριθμός τμημάτων του τόξου) που ορίζει ο χρήστης. Όσο πιο 

συγκεκριμένος είναι ο αριθμός των τμημάτων, τόσο υψηλότερος είναι ο βαθμός ταύτισης μεταξύ της 

πολυγραμμής που μετατρέπεται. 

 

 

 

 

Μενού: Εισαγωγή εντολής : Express tools>Draw>Spline to  PlineΕισαγωγή εντολής : Express 

tools>Draw>Spline to Pline:  SPTPL Για παράδειγμα, σχεδιάστε το ακόλουθο δείγμα spline με 5 τόξα όπως φαίνετι 

στην εικόνα: 

 

 

 

 

 

 

 

Αφού ξεκινήσει η εντολή SPTPL, επιλέξτε το αντικείμενο 

(Spline). Μετά την επιλογή του αντικειμένου, θα 

εμφανιστεί ένα μήνυμα προτροπής > Delete the spline? 

Ναι(Y) / Όχι(N): Σε αυτή την περίπτωση, αν επιλέξουμε 

Yes (Ναι), η επιλογή αυτή θα διαγράψει το spline στη 

θέση του, αλλά αν επιλέξουμε No (Όχι), θα διατηρήσει το 

spline. Μετά την εισαγωγή της 
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επιλογής delete spline, θα εμφανιστεί ένα μήνυμα 

προτροπής > Please enter the number of arcs Non-zero: 

Και πρέπει να εισάγουμε μια τιμή μεγαλύτερη από το 

μηδέν, για παράδειγμα 8. Αυτή η τιμή καθορίζει τον 

αριθμό των τόξων του τμήματος που θα δημιουργηθούν 

στη νέα πολυγραμμή. 

 
Γραμμή προς Γραμμή: Αυτή η συνάρτηση μπορεί να μετατρέψει μία ή περισσότερες συνδεδεμένες ευθείες 

γραμμές, τόξα σε μία πολυγραμμή. Μπορείτε να έχετε πρόσβαση από: 

Μενού: Γραμμή σε Πολυγραμμή 

Εισαγωγή εντολής: Express 

tools>Draw>Line to Polyline: 

Line2pl 

 
Μετά την εκκίνηση της 

εντολής, θα 

εμφανιστεί ένα 

μήνυμα προτροπής> 

Please enter the join 

precision: 0 

Η ακρίβεια Join θα 

καθορίσει τον χώρο 

ένωσης μεταξύ των 

τελικών σημείων κάθε 

αντικειμένου. Σε αυτή 

την περίπτωση, 

θα εισάγουμε την τιμή 0 για να εξασφαλίσουμε τη σύνδεση μεταξύ των αντικειμένων (γραμμών). 

 
Αφού εισαγάγετε την τιμή σύνδεσης, επιλέξτε τα αντικείμενα που πρόκειται να συνδεθούν και να μετατραπούν σε Πολυγραμμή: 

 

Και τέλος, έχετε δημιουργήσει με επιτυχία μια πολυγραμμή: 
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8. Εργαλεία 

Command Alias：Αυτή η λειτουργία επιτρέπει στους χρήστες να προσθέτουν, να τροποποιούν 

και να διαγράφουν ψευδώνυμα εντολών και εντολές κελύφους. Μενού: Εργαλεία > Εργαλεία 

>Command Alias 

Είσοδος εντολών: ALIAS 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή και θα 

εμφανιστεί ένα παράθυρο 

διαλόγου. 

2. Επιλέξτε τις εντολές που 

θέλετε να διαγράψετε και 

κάντε κλικ στο κουμπί 

"Κατάργηση" για να 

διαγράψετε το ψευδώνυμο 

εντολής. 

3. Επιλέξτε την εντολή που 

θέλετε να τροποποιήσετε και 

κάντε κλικ στο κουμπί 

"Edit" (Επεξεργασία), οπότε 

θα εμφανιστεί ένα 

παράθυρο διαλόγου. 

4. Κάντε κλικ στο "OK" για να ολοκληρώσετε την επεξεργασία. 

 

Επεξεργαστής μεταβλητών συστήματος： Σας επιτρέπει να προβάλλετε, να αποθηκεύετε, να 

φορτώνετε και να συγκρίνετε τις ρυθμίσεις μεταβλητών συστήματος. Μενού: Εργαλεία > 

Εργαλεία >Επεξεργαστής μεταβλητών συστήματος 

Είσοδος εντολών: SYSVDLG 

 
Παράθυρο διαλόγου Μεταβλητές συστήματος Επιλογές: 

 
Πλαίσιο λίστας: Εμφανίζει μια λίστα μεταβλητών συστήματος. Το πεδίο επεξεργασίας πάνω από το πλαίσιο λίστας επιτρέπει το 

φιλτράρισμα της εμφάνισης του πλαισίου λίστας με βάση την εισαγωγή του χρήστη. Για παράδειγμα, η εισαγωγή DIM* στο πεδίο 

επεξεργασίας φιλτράρει τη λίστα ώστε να εμφανίζονται μόνο οι μεταβλητές συστήματος που αρχίζουν με DIM. Εάν δεν 

εισαχθεί τίποτα στο πεδίο επεξεργασίας, η λίστα εμφανίζει όλες τις μεταβλητές συστήματος 

μεταβλητές. Εάν επισημανθούν περισσότερες από μία μεταβλητές συστήματος, όλες οι επιλογές επεξεργασίας και εμφάνισης δεν είναι 
διαθέσιμες. 

 

Νέα αξία: Εμφανίζει την τρέχουσα τιμή της μεταβλητής συστήματος που επισημαίνεται στο πλαίσιο λίστας και σας επιτρέπει 

να επεξεργαστείτε την τιμή αυτή. Καμία αλλαγή δεν δεσμεύεται μέχρι να κλείσει το παράθυρο διαλόγου με το κουμπί OK. 
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Τρέχουσα αξία: Εμφανίζει την τιμή της μεταβλητής του συστήματος που επισημαίνεται στο  το πλαίσιο λίστας σαν να είχε 

ξεκινήσει το SYSVDLG. 

 

Αρχική τιμή: Εμφανίζει την αρχική τιμή της μεταβλητής συστήματος που επισημαίνεται στο πλαίσιο λίστας. Αυτή είναι η τιμή 

που έχει η μεταβλητή συστήματος σε ένα νέο σχέδιο. 

 

Αποθηκεύτηκε σε: Εμφανίζει πού είναι αποθηκευμένη η τιμή της μεταβλητής συστήματος που επισημαίνεται. 

 

Τύπος: Για παράδειγμα, ακέραιος, πραγματικός, συμβολοσειρά κ.ο.κ. 

 

Αποθήκευση όλων: Αποθηκεύει τις τρέχουσες ρυθμίσεις μεταβλητών συστήματος σε ένα SVF ή SCR. 

αρχείο. Τα αρχεία SVF μπορούν να διαβαστούν στο SYSVDLG και τα αρχεία SCR είναι σενάρια AutoCAD που μπορούν να 

εκτελεστούν από τη γραμμή εντολών του AutoCAD. Το κουμπί θα εμφανίζει Save All, Save Selected ή Save Filtered 

ανάλογα με την κατάσταση της λίστας μεταβλητών συστήματος. 

 

Διαβάστε: Επαναφέρει αποθηκευμένες ρυθμίσεις από ένα αρχείο SVF. Δεν αποθηκεύονται αλλαγές στο σχέδιο μέχρι να 

επιλέξετε OK. Όλες οι αλλαγές που εκκρεμούν μπορούν να απορριφθούν 

με το κουμπί Ακύρωση. Το SYSVDLG θα επικυρώνει τις νέες τιμές των μεταβλητών συστήματος καθώς αυτές αλλάζουν. 

 

Συγκρίνετε με το saved: Συγκρίνει τις μεταβλητές του σχεδίου με το αποθηκευμένο αρχείο SCR. 
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Κάντε Linetype: Δημιουργεί ένα linetype με βάση επιλεγμένα 

αντικείμενα. Μενού: Εργαλεία > Εργαλεία > Δημιουργία 

γραμμοτύπου 

Είσοδος εντολών: MKLTYPE 

 
Μόλις ξεκινήσει η εντολή, θα εμφανιστεί το ακόλουθο 

παράθυρο. Μπορείτε να βρείτε τα αρχεία γραμμής (*.lin) και να 

τα εφαρμόσετε στο τρέχον σχέδιο. 

 
 
 

 

Φτιάξτε σχήμα: Δημιουργεί έναν ορισμό σχήματος με βάση επιλεγμένα 

αντικείμενα. Μενού: Εργαλεία> Εργαλεία>Δημιουργία σχήματος 

Είσοδος εντολών: MKLTYPE 
 
 

 
Έλεγχος σημείου διακοπής: Μπορεί να επισημάνει μη κλειστά σημεία τέλους μεταξύ επιλεγμένων γραμμών, 

πολυγραμμών ή τόξων και να τα κλείσει αμέσως όταν ζητείται ότι η περιοχή δεν είναι κλειστή κατά τη χάραξη, τον 

υπολογισμό περιοχών ή τη δημιουργία περιοχών. 

 
Μενού: Εργαλεία> Εργαλεία> Έλεγχος σημείου 

ρήξης Εισαγωγή εντολής: CLOSELINE 
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9. Επιτραπέζια εργαλεία 

Συμπλήρωση πίνακα: Μπορείτε να χρησιμοποιήσετε αυτή τη λειτουργία 

για να συμπληρώσετε τον πίνακα ή να επεξεργαστείτε τα κείμενα. 

Μενού: Πίνακας: Express>Εργαλεία πίνακα>Συμπλήρωση 

πίνακα 

Είσοδος εντολών: FORMTXT 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Κάντε κλικ στο κελί ή πληκτρολογήστε "Q" και θα εμφανιστεί ένα παράθυρο διαλόγου. 

3. Στο παράθυρο διαλόγου μπορείτε να ορίσετε τη μόδα 

ύψους κειμένου, τη μόδα και άλλα χαρακτηριστικά 

κειμένου. 

4. Κάντε κλικ στην κενή περιοχή ενός κελιού και εισαγάγετε απευθείας κείμενα. 

5. Enter για να ολοκληρώσετε τη συμπλήρωση. 

 
Τραπέζι κλήρωσης: Αυτή η λειτουργία μπορεί να σας βοηθήσει να σχεδιάσετε έναν πίνακα. 

 
Μενού: Εισαγωγή εντολής: 

Express>Εργαλεία Πίνακα> Σχεδίαση 

Πίνακα: BGE 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε το πρώτο σημείο του πίνακα. 

3. Η γραμμή εντολών ζητάει. 

a. Πατήστε το πλήκτρο Q και το πλάτος της φόρμας θα αυξηθεί λίγο, χρησιμοποιείται για τη ρύθμιση του οριζόντιου πλάτους. 

b. Πατήστε το πλήκτρο W και το πλάτος της φόρμας θα μειωθεί λίγο, για να ρυθμίσετε το οριζόντιο πλάτος. 

c. Πατήστε το πλήκτρο A και το ύψος της φόρμας θα αυξηθεί λίγο, για να ρυθμίσετε το κάθετο ύψος. 

d. Πατήστε το πλήκτρο S και το ύψος της φόρμας θα μειωθεί λίγο, για να ρυθμίσετε το κατακόρυφο ύψος. 

4. Μπορείτε να εισαγάγετε τις αντίστοιχες επιλογές για να ρυθμίσετε το μέγεθος του πίνακα. 

5. Καθορίστε το δεύτερο σημείο για να ολοκληρώσετε τη σχεδίαση του πίνακα. 
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Συγχώνευση κελιών: Αυτή η λειτουργία είναι παρόμοια με 

τη συγχώνευση κελιών στο Excel. Μενού: Συγχώνευση 

κελιών: Express>Εργαλεία πίνακα>Συγχώνευση κελιών 

Είσοδος εντολών: BGH 
 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε το όριο της φόρμας προς συγχώνευση ή το πρώτο κελί, όπως φαίνεται παρακάτω. 

3. Επίδραση συγχώνευσης όπως παρακάτω. Και πατήστε Enter για να ολοκληρώσετε την εντολή. 

 
Δείγμα1: Καθορίστε το όριο της φόρμας 

 
 

 
Δείγμα2: Καθορίστε το πρώτο κελί και ένα άλλο κελί 

 

 

 

Διαχωρισμένα κύτταρα: Αυτή η λειτουργία είναι παρόμοια 

με τη διαίρεση κελιών στο Excel. Μενού: 

Express>Εργαλεία πίνακα>Διαίρεση κελιών 

Είσοδος εντολών: BGFG 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε το κελί που πρέπει να χωριστεί. 

3. Μετακινήστε τον κέρσορα, όταν οι γραμμές και οι στήλες 

είναι ένα μέγεθος πάνω. κάντε κλικ στο ποντίκι και το κελί 

θα χωριστεί αυτόματα. 
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Προσθήκη προκατάληψης: Αυτή η λειτουργία μπορεί να προσθέσει προκατάληψη για ένα κελί. 

Κάντε κλικ στο σημείο αρχής και τέλους σύμφωνα με τις οδηγίες και το σύστημα θα παρέχει ένα στιγμιότυπο 

τομής και μπορεί εύκολα να βρει το σημείο αρχής και τέλους της προκατάληψης, ή μπορείτε να κάνετε κλικ σε 

οποιαδήποτε περιοχή σε ένα κελί και το σύστημα θα βρει αυτόματα το πάνω αριστερό σημείο του κελιού, τότε το 

σύστημα θα σας ζητήσει να επιλέξετε το σημείο τέλους, μπορείτε επίσης να κάνετε κλικ σε οποιαδήποτε περιοχή 

στο κελί, το σύστημα θα πάρει το κάτω δεξιό σημείο ως σημείο τέλους αυτόματα, με αυτόν τον τρόπο προστίθεται 

μια προκατάληψη σε ένα κελί. 

 
Μενού: Εισαγωγή εντολής: 

Express>Εργαλεία πίνακα>Προσθήκη 

μεροληψίας: BGX 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε το σημείο έναρξης, μπορείτε να κάνετε κλικ 

στο επάνω αριστερό σημείο ή να κάνετε κλικ στην κενή 

περιοχή του κελιού. 

3. Καθορίστε το τελικό σημείο για να ολοκληρώσετε τη χάραξη της στρέβλωσης. 

 

 

Σύρετε πολλαπλές γραμμές: Μπορείτε να αλλάξετε το πλάτος της γραμμής και της στήλης σύροντας τη γραμμή του 

πίνακα και τα αντίστοιχα τμήματα της γραμμής θα αλλάξουν επίσης. Για παράδειγμα, σύρετε τη γραμμή που 

επιλέξατε προς τη δεξιά πλευρά και όλες οι γραμμές στη δεξιά πλευρά θα μετακινηθούν αντίστοιχα προς τη δεξιά 

πλευρά. 

 
Μενού: Εισαγωγή εντολής: Express>Εργαλεία 

πίνακα>Συγκέντρωση πολλαπλών γραμμών: BGMT 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε τη γραμμή του πίνακα για σύρσιμο. 

3. Καθορίστε το σημείο ή την απόσταση στην οποία θέλετε να σύρετε (το αριστερό είναι θετικό). 

4. Enter για να ολοκληρώσετε τη μετακίνηση. 
 

 
 

 
Γραμμή έλξης: γραμμή θα μετακινήσει μόνο τη γραμμή που έχετε επιλέξει και άλλες σχετικές γραμμές δεν θα 

μετακινηθούν. Μενού: Γραμμή σύρσιμο: Express>Εργαλεία πίνακα>Στραβήξτε γραμμή 
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Είσοδος εντολών: BGST 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε τη γραμμή του πίνακα για σύρσιμο. 

3. Καθορίστε το σημείο ή την απόσταση στην οποία θέλετε να σύρετε (το αριστερό είναι θετικό). 

4. Enter για να ολοκληρώσετε την εντολή. 

 

 

 

Τμήμα Drag: Αυτή η εντολή δεν θα αλλάξει τις γραμμές ολόκληρου του πίνακα, αλλά απλώς θα μετακινήσει την 

πλευρική γραμμή ενός κελιού. Μενού: Μεταφορά τμήματος: Express>Εργαλεία πίνακα>Συγκέντρωση 

τμήματος 

Είσοδος εντολών: BGJT 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε τη γραμμή του πίνακα για σύρσιμο 

3. Καθορίστε το σημείο ή την απόσταση που θέλετε να σύρετε (το αριστερό είναι θετικό). 

4. Enter για να ολοκληρώσετε την εντολή (Εικ.24). 
 

 

Κλίμακα επιλογής: Αυτή η λειτουργία μπορεί να μεγεθύνει και να σμικρύνει ολόκληρο τον πίνακα με βάση 

το σημείο που έχετε καθορίσει. Μενού: Κλίμακα επιλογής 

Είσοδος εντολών: BGSF 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή και καθορίστε το σημείο βάσης για τη γραμμή του πίνακα. 

2. Μετακινήστε τον κέρσορα και ο πίνακας θα μεγεθυνθεί. 

3. Σύρετε σε κατάλληλη θέση και κάντε κλικ. 
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Προσθήκη γραμμής: Αυτή η λειτουργία μπορεί να προσθέσει γραμμές στον πίνακα. 

 
Μενού: Εισαγωγή εντολής: 

Express>Εργαλεία πίνακα>Προσθήκη 

γραμμής: BGZH 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε τη θέση της νέας γραμμής. 

3. Το σύστημα θα προσθέσει μια γραμμή κάτω από το σημείο που καθορίσατε. 
 
 

 

Προσθήκη στήλης: Αυτή η λειτουργία μπορεί να προσθέσει 

νέες στήλες στον πίνακα. Μενού: Express>Εργαλεία 

πίνακα>Προσθήκη στήλης 

Είσοδος εντολών: BGZL 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε την κατεύθυνση της νέας στήλης. 

3. Το σύστημα θα προσθέσει μια νέα στήλη στη δεξιά πλευρά του πίνακα. 

 

 

Διαγραφή γραμμής: Αυτή η λειτουργία μπορεί να διαγράψει τη γραμμή του πίνακα που καθορίσατε. 

 
Μενού: Σειρά: Express>Εργαλεία 

Πίνακα>Διαγραφή Σειράς Εισαγωγή 

εντολής: Express>Εργαλεία 

Πίνακα>Διαγραφή Σειράς: BGSH 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή και καθορίστε το κελί της γραμμής για διαγραφή. 

2. Το σύστημα θα διαγράψει τη γραμμή που καθορίσατε. 
 

 

Διαγραφή στήλης: Αυτή η λειτουργία μπορεί να διαγράψει τις 

στήλες που έχετε καθορίσει. Μενού: Στήλη: 

Express>Εργαλεία πίνακα>Διαγραφή στήλης 
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Είσοδος εντολών: BGSL 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε το κελί της στήλης για διαγραφή. 

3. Το σύστημα θα διαγράψει τη στήλη που καθορίσατε. 
 
 

 

Διαγραφή πίνακα: Αυτή η λειτουργία μπορεί να διαγράψει τον 

πίνακα που επιλέξατε. Μενού: Πίνακας: Express>Εργαλεία 

πίνακα>Διαγραφή πίνακα 

Είσοδος εντολών: BGSC 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή και καθορίστε τον πίνακα προς διαγραφή. 

2. Enter για να ολοκληρώσετε τη διαγραφή. 
 

 

Προσαρμογή προσανατολισμού κειμένου: Αυτή η λειτουργία χρησιμοποιείται για τη 

ρύθμιση της ευθυγράμμισης των κειμένων. Μενού: Προσαρμογή προσανατολισμού 

κειμένου 

Είσοδος εντολών: BGJS 

Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή και επιλέξτε το κείμενο για προσαρμογή. 

2. Πιέστε Enter και η γραμμή εντολών θα σας ζητήσει τη λειτουργία θέσης. 

3. Εδώ εισάγουμε το "1" για να επιλέξουμε την αριστερή στοίχιση. 

4. Το κείμενο που καθορίσατε θα ευθυγραμμιστεί προς τα αριστερά, όπως φαίνεται παρακάτω. 

 

 
Ανακοίνωση: 

1. Αυτή η λειτουργία μπορεί να προσανατολίσει και να προσαρμόσει μόνο το κείμενο του πίνακα στο επίπεδο ΠΙΝΑΚΑΣ. 

2. Η απόσταση από τη γραμμή του τραπεζιού με τη χρήση αριστερής ευθυγράμμισης ή δεξιάς ευθυγράμμισης έχει ήδη 
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οριστεί από το πρόγραμμα, εάν πιστεύετε ότι η απόσταση δεν είναι κατάλληλη, μπορείτε να χρησιμοποιήσετε την 

εντολή GstarCAD για να ρυθμίσετε την απόσταση. 

Πίνακας CAD σε Excel: Αυτή η εντολή θα μετατρέψει τα φύλλα, που αποτελούνται από γραμμή/σχιστογραμμή και 

κείμενο/κείμενο στο CAD, σε EXCEL. Μενού: Πίνακας CAD σε Excel: Express>Εργαλεία Πίνακας> Πίνακας CAD 

σε Excel 

Είσοδος εντολών: GC_CTE 

 
Μέθοδος λειτουργίας: 

1. Ξεκινήστε την εντολή και καθορίστε την αναλογία μετατροπής. 

2. Επιλέξτε τον πίνακα που πρέπει να αλλάξει και πατήστε enter, το 

σύστημα θα ανοίξει αυτόματα το EXCEL μετά τη μετατροπή. 

3. Αποθηκεύστε το φύλλο EXCEL. 
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10. Εργαλεία συντονισμού 

Συντεταγμένες εξαγωγής: Είναι ευκολότερο να εξαγάγετε δεδομένα συντεταγμένων από το dawing με το 

καινοτόμο εργαλείο COEXPORT. Μενού: Συντεταγμένες>Εργαλεία συντεταγμένων>Εξαγωγή 

συντεταγμένων 

Είσοδος εντολών: DIMCOORD 

 
Μπορείτε να επιλέξετε όσα σημεία χρειάζεστε από το σχέδιό σας και να εξάγετε όλα τα δεδομένα συντεταγμένων σε 

αρχείο .txt ή .xls. Αυτό το εργαλείο θα μπορούσε να εφαρμοστεί εύκολα σε σχέδια σχεδιασμού, τοπογραφίας, 

χαρτογράφησης και κατασκευής. 

 
Εκτελέστε την εντολή COEXPORT και επιλέξτε ποια μορφή (.txt/.xls) θέλετε να αποθηκεύσετε το αρχείο.Στη συνέχεια, 

επιλέξτε όλα τα σημεία συντεταγμένων στο τρέχον σχέδιό σας. Κάθε φορά που επιλέγετε ένα σημείο, τα δεδομένα του 

θα αποθηκεύονται αυτόματα στο αρχείο που επιλέξατε. Για να ολοκληρώσετε τη διαδικασία, πατήστε Enter. 

Μπορείτε να ανοίξετε το αποθηκευμένο αρχείο και να ελέγξετε όλα τα δεδομένα συντεταγμένων (X,Y,Z) που έχουν 

εξαχθεί. 
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Σημείο συντεταγμένων: Διαστάσεις της συντεταγμένης του σημείου στο σχέδιο. 

 
Μενού: Συντεταγμένα Εργαλεία>Συντεταγμένα 

Σημεία Εισαγωγή εντολών: Express>Εργαλεία 

Συντεταγμένων>Συντεταγμένα Σημεία: DIMCOORD 

 

 
 
 
 

 
Αλλαγή συντεταγμένων Z: Επιλέξτε πολλά αντικείμενα ταυτόχρονα και, 

στη συνέχεια, αλλάξτε τις συντεταγμένες Ζ μαζί. 

 
Μενού: Συντεταγμένες>Αλλαγή Συντεταγμένων Z 

Εισαγωγή εντολής: CHANGEZ 
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11. Εργαλεία σχεδίασης 

 
Σύγκριση γραφικών: Όπως γνωρίζουμε, η λειτουργία σύγκρισης σχεδίων στο GstarCAD μπορεί να χρησιμοποιηθεί 

για τη σύγκριση παρόμοιων σχεδίων που περιέχουν σχεδόν αριθμό σχεδιασμένων αντικειμένων μεταξύ τους, ειδικά 

για τη σύγκριση διαφορετικών εκδόσεων σχεδίων αναθεώρησης. 

Μενού: Σύγκριση γραφικών Εισαγωγή εντολών: OCMP 

 
Το Drawing compare μπορεί να κάνει συγκρίσεις μεταξύ δύο 

παρόμοιων σχεδίων (παλιό DWG και νέο DWG) και να τα 

δημιουργήσει ως ξεχωριστά αρχεία. Αφού πατήσετε το 

κουμπί COMPARE μέσα στο πλαίσιο διαλόγου CompareDwg, 

το πρόγραμμα θα δημιουργήσει και θα ανοίξει 

_old και _new.dwg, όπου μπορείτε να δείτε τις διαφορές 

μεταξύ των σχεδίων. 

Η Σύγκριση σχεδίασης μπορεί να εντοπίσει διαφορές 

(σχεδιασμένα αντικείμενα) και να εμφανίσει το αποτέλεσμα 

με διαφορετικά χρώματα, π.χ. αν μια γραμμή τροποποιηθεί, 

αφαιρεθεί ή σχεδιαστεί πρόσφατα, θα εμφανιστεί με 

διαφορετικά χρώματα. 
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Υπάρχει όμως και κάτι άλλο που η σύγκριση με τη 

ζωγραφική δεν θα μπορούσε να επιτύχει με 

τόση ακρίβεια. Το drawing compare δεν μπορεί 

να εισάγει και να εμφανίσει τα συγκρινόμενα 

αντικείμενα στον τρέχοντα χώρο εργασίας του 

σχεδίου που εργάζεστε σε πραγματικό χρόνο. 

Εκτός αυτού, η σύγκριση σχεδίασης δεν μπορεί 

να δείξει τις λεπτομέρειες για το πώς βρίσκονταν 

τα αντικείμενα πριν από την τροποποίησή τους. 

Επομένως, οι λεπτομέρειες είναι πολύ σημαντικές όταν συγκρίνουμε αντικείμενα. Τώρα το νέο και καινοτόμο 

εργαλείο Σύγκριση γραφικών μπορεί να κάνει περισσότερα! Δεν συγκρίνει μόνο δύο σχέδια με παρόμοια γεωμετρία 

αντικειμένων και βρίσκει τις διαφορές, αλλά εμφανίζει επίσης τις λεπτομέρειες οποιασδήποτε αλλαγής στο τρέχον χώρο 

εργασίας του σχεδίου σας σε πραγματικό χρόνο, π.χ. αν μια γραμμή τροποποιηθεί, μόνο το αλλαγμένο τμήμα της γραμμής 

εμφανίζεται με διαφορετικό χρώμα. Το αμετάβλητο τμήμα παραμένει αμετάβλητο. 

 
Παράθυρο διαλόγου σύγκρισης γραφικών 

Μπορείτε να ενεργοποιήσετε το παράθυρο διαλόγου Σύγκριση γραφικών με την εντολή OCMP στη γραμμή εντολών ή με δυναμική εισαγωγή. 

 
Καθορίστε το σχέδιο: μεταξύ επιλεγμένων 

αντικειμένων στο τρέχον σχέδιό σας ή να 

καθορίσετε αρχεία. 

Επιλέξτε Αντικείμενα: Προσφέρει δύο επιλογές 

επιλογής αντικειμένων, συμπεριλαμβανομένων των 

σημείων βάσης τους προς σύγκριση. 

Επιλέξτε τα αντικείμενα βάσης και το σημείο βάσης: 

Αυτή η επιλογή επιτρέπει την επιλογή όλων των 

αντικειμένων, συμπεριλαμβανομένου ενός σημείου 

βάσης, ως πρώτο σύνολο επιλογής προς σύγκριση. 

Επιλέξτε αντικείμενα σύγκρισης και σημείο βάσης: Αυτή η 

επιλογή επιτρέπει την επιλογή όλων των αντικειμένων, 

συμπεριλαμβανομένου ενός σημείου βάσης, ως ένα 

δεύτερο σύνολο επιλογής που θα συγκριθεί με το 

πρώτο σύνολο επιλογής. 

 
Καθορισμός αρχείου: Η επιλογή αυτή επιτρέπει την αναζήτηση δύο 

αρχείων σχεδίασης προς σύγκριση, γνωστών ως αρχείο βάσης και 

αρχείο σύγκρισης. 

 
Σχέδιο εξόδου: Προσφέρει δύο επιλογές σχεδίασης σε σύγκριση με την έξοδο. 

 
Εισαγωγή τρέχοντος εγγράφου: Αυτή η επιλογή επιτρέπει την 

εισαγωγή του συγκριμένου συνόλου επιλεγμένων αντικειμένων στον 

τρέχοντα χώρο εργασίας. 
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Εξαγωγή σε αρχείο: Αυτή η επιλογή επιτρέπει την εξαγωγή του 

συγκριμένου συνόλου επιλεγμένων αντικειμένων σε ένα αρχείο 

σχεδίασης. 

 
Ρυθμίσεις εξόδου: για όλα τα επιλεγμένα αντικείμενα που πρόκειται 

να συγκριθούν για να ενισχύσετε τις οπτικές διαφορές μεταξύ 

τους. 

 

 
Εισαγωγή Συγκριμένου συνόλου αντικειμένων στο τρέχον σχέδιο 

Για να εισαγάγετε ένα σύνολο συγκρινόμενων αντικειμένων στο 

τρέχον σχέδιο, επιλέξτε πρώτα το κουμπί Επιλογή αντικειμένων 

βάσης και σημείου βάσης. Στη συνέχεια, επιλέξτε όλα τα 

αντικείμενα ως πρώτο σύνολο επιλογής που ονομάζεται 

αντικείμενα βάσης και καθορίστε ένα σημείο βάσης για τα 

αντικείμενα βάσης.Στη συνέχεια, επιλέξτε το κουμπί Select compare 

objects and base point και επαναλάβετε όλη την προηγούμενη 

διαδικασία που αναφέρθηκε παραπάνω. 

  
 
 

 
Στην περιοχή Output Drawing, επιλέξτε την επιλογή 

Insert current document (Εισαγωγή τρέχοντος 

εγγράφου). Εάν θέλετε να ρυθμίσετε οπτικές ιδιότητες 

για τα συγκρινόμενα αντικείμενα, κάντε κλικ στο κουμπί 

Ρυθμίσεις εξόδου. Μετά από αυτό μπορείτε να 

τοποθετήσετε τα συγκρινόμενα αντικείμενα που έχουν 

οριστεί σε ένα βολικό σημείο σύμφωνα με τις ανάγκες 

σας. 
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Σχεδίαση Σύγκριση: Σύγκριση σχεδίων: Η σύγκριση σχεδίων είναι μια αποκλειστική λειτουργία στο GstarCAD, η οποία 

προστίθεται σύμφωνα με τις απαιτήσεις του χρήστη. 

Ενισχύει τη συνεργασία με τη χρήση χρωματικά κωδικοποιημένων οθονών για την εμφάνιση στοιχείων σε ένα σχέδιο 

που έχουν αλλάξει, προστεθεί ή διαγραφεί από άλλα μέλη της ομάδας σχεδιασμού. Μπορούν επίσης να 

παρακολουθούνται οι αλλαγές σε στοιχεία όπως στυλ, χαρακτηριστικό μπλοκ, αντικείμενο μπλοκ. Το πρόγραμμα θα 

αναλύσει αυτόματα τις διαφορές μεταξύ δύο σχεδίων. Στη συνέχεια, οι διαφορές θα επισημαίνονται με διαφορετικά 

χρώματα. Οι χρήστες μπορούν επίσης να ορίσουν το χρώμα σήμανσης κάνοντας κλικ στο κουμπί "επιλογή". 

 
Μενού: Σύγκριση Σύγκριση Εισαγωγή εντολής: CMP 

 
Μόλις ξεκινήσει η εντολή, θα εμφανιστεί το ακόλουθο παράθυρο: 

 

 

 

 

Σε αυτό το παράθυρο, πρέπει να περιηγηθείτε 

στο παλιό DWG (αρχικό σχέδιο) και στο νέο 

DWG (τροποποιημένο σχέδιο). Μπορείτε 

επίσης να ορίσετε μια διαδρομή για την 

αποθήκευση του συγκρινόμενου σχεδίου. Στη 

συνέχεια, επιλέξτε το κουμπί Option (Επιλογή) για να 

ρυθμίσετε τις παραμέτρους σύγκρισης. 

 
 
 

 
Αφού ρυθμίσετε τις παραμέτρους σύγκρισης, όπως: 

χρώματα, στρώματα, τύπος γραμμής κ.λπ., 

επιλέξτε ΟΚ για να επιβεβαιώσετε αυτές τις 

παραμέτρους. Σημείωση: Δώστε προσοχή στο 

χρώμα του σήματος, επειδή τα διαγραμμένα, 

τροποποιημένα και προστιθέμενα αντικείμενα 

θα τα υιοθετήσουν στο συγκρινόμενο σχέδιο. 

Στη συνέχεια, επιλέξτε το κουμπί Σύγκριση στο 

παρακάτω παράθυρο για να συγκρίνετε τα δύο 

σχέδια. 
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Κλείδωμα σχεδίασης: Επεξεργαστείτε ορισμένα αντικείμενα ή ολόκληρο το σχέδιο σε μη επεξεργάσιμη κατάσταση 

και προσθέστε τη λειτουργία ορισμού κωδικού πρόσβασης για το κλείδωμα των αντικειμένων. Το επεξεργασμένο σχέδιο 

μπορεί να περιηγηθεί και να εκτυπωθεί, αλλά δεν μπορεί να αποδομηθεί ή να επεξεργαστεί.  

 
Μενού: Εργαλεία > Εργαλεία σχεδίασης > Κλείδωμα 

σχεδίασης Εισαγωγή εντολής: LOCKUP 

 
Αφού ενεργοποιήσετε την εντολή LOCKUP, εμφανίζονται οι ακόλουθες προτροπές: 

 

 

 
Τα αντικείμενα δεν θα μπορούν να τροποποιηθούν μετά τη χρήση αυτής της λειτουργίας, θέλετε να συνεχίσετε; 

[Ναι(Y)/Όχι(N)]: Επιβεβαιώνει αν θα συνεχιστεί η εκτέλεση της εντολής. 

 

Επιλέξτε Αντικείμενο: Επιλέγει τα αντικείμενα που θέλετε να κλειδώσετε στο σχέδιο. Εάν κάποιο από αυτά είναι 

ήδη κλειδωμένο, θα εμφανιστεί στη γραμμή εντολών η προτροπή "1 was on a locked layer" (1 βρισκόταν σε 

κλειδωμένο επίπεδο). 

Θέλετε να δημιουργήσετε έναν κωδικό πρόσβασης [Ναι(Y)/Όχι(N)]: Ρωτάει αν θα προστεθεί κωδικός πρόσβασης μετά το κλείδωμα των 
αντικειμένων. 

Εισαγωγή κωδικού πρόσβασης: Εισάγει τον κωδικό πρόσβασης που ορίσατε για τα κλειδωμένα αντικείμενα. 
 

 
Σημείωση: 

• Τα κλειδωμένα αντικείμενα μπορούν να επιλεγούν ως 

όρια περιποίησης σε ξεκλειδωμένα αντικείμενα. 

• Τα κλειδωμένα αντικείμενα μετατρέπονται σε αναφορά 
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μπλοκ και εμφανίζονται σε ένα προσωρινό επίπεδο. 

• Τα κλειδωμένα αντικείμενα μπορούν να επιλεγούν. Ένα 

μικρό σημάδι κλειδώματος εμφανίζεται όταν περνάτε τον 

κέρσορα πάνω σε ένα κλειδωμένο αντικείμενο. 

• Κατά την εκτέλεση της εντολής ERASE για τη διαγραφή της κλειδωμένης 

αντικείμενα, η εντολή διαγραφής δεν μπορεί να εκτελεστεί και στη 

γραμμή εντολών θα εμφανιστεί η προτροπή "1 was on a locked 

layer" (1 ήταν σε κλειδωμένο επίπεδο). 

• Οι εκδόσεις που είναι χαμηλότερες από το GstarCAD 2023 ενδέχεται να μην μπορούν να ξεκλειδώσουν τα αντικείμενα που είναι 
κλειδωμένα με κωδικό πρόσβασης. 

 
Καθαρισμός παρτίδας (Καθαρισμός αρχείων παρτίδας): DWG: Αυτή η νέα λειτουργία επιτρέπει την εκκαθάριση 

παρτίδας των περιττών αντικειμένων, όπως μπλοκ, στρώματα, τύπος γραμμής, στυλ διάστασης ή στυλ κειμένου σε 

πολλά αρχεία DWG. Το εργαλείο Batpurge δεν χρειάζεται να ανοίξετε αρχεία. Εκτελεί απευθείας την εντολή καθαρισμού, 

γεγονός που την καθιστά να εκτελείται με πολύ υψηλή απόδοση. Μπορείτε να έχετε πρόσβαση σε αυτό από: 

 
Μενού: Εκκαθάριση παρτίδας Εισαγωγή εντολών: . 

 
Αφού ξεκινήσει η εντολή, θα εμφανιστεί ένα παράθυρο διαλόγου. Σε αυτό το παράθυρο διαλόγου μπορείτε να 

προσθέσετε, να επιλέξετε, να αποεπιλέξετε, να καθαρίσετε και να ξεκινήσετε την εκκαθάριση αντικειμένων μέσα σε 

αρχεία DWG με τα εξής 

επιλογές: 

 
Προσθήκη αρχείων: Προσθήκη ενός ή περισσότερων 

αρχείων δέσμης από την επιλεγμένη διαδρομή. 

Προσθήκη φακέλου: Προσθήκη αρχείων DWG από έναν επιλεγμένο φάκελο. 

Επιλογή όλων: Επιλέξτε όλες τις λίστες 

αρχείων DWG ταυτόχρονα. Επιλέξτε Κανένα: 

Αποεπιλογή όλων των αρχείων DWG 

ταυτόχρονα. Διαγραφή: Διαγραφή επιλεγμένων 

αντικειμένων στη λίστα αρχείων. Clear 

(Εκκαθάριση): Καθαρισμός όλων των λιστών 

αρχείων DWG ταυτόχρονα. 

Ξεκινήστε την εκκαθάριση: Ξεκινά την εκκαθάριση της επιλεγμένης λίστας αρχείων DWG. Μετά την εκκαθάριση, το 

GstarCAD θα δημιουργήσει ένα αρχείο σημειώσεων στο οποίο μπορείτε να δείτε τις λεπτομέρειες της εκκαθάρισης. 

Ημερολόγιο: Μπορείτε να συνδεθείτε στο αρχείο σημειώσεων που δημιουργήθηκε και να δείτε την εγγραφή 

λεπτομερειών της παρτίδας καθαρισμού. 
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Μετακίνηση BAK: Αλλάζει το φάκελο προορισμού για τα αρχεία 

αντιγράφων ασφαλείας σχεδίασης (BAK). Μενού: Μετακίνηση BAK

 Εισαγωγή εντολών: 

MOVEBAK 

Η εντολή MOVEBAK αλλάζει το φάκελο προορισμού για τα αρχεία αντιγράφων ασφαλείας σχεδίασης (BAK). Μόλις 

καθορίσετε μια διαδρομή, τα αρχεία BAK του σχεδίου τοποθετούνται σε αυτή τη διαδρομή μετά από κάθε 

αποθήκευση. 

Εισάγετε νέα τιμή για το MOVEBAK ή για κανένα <τρέχουσα ρύθμιση>: 

Πληκτρολογήστε ένα . (τελεία) για κανένα ή πληκτρολογήστε το όνομα του φακέλου. 

Εάν πληκτρολογήσετε ".", το όνομα του φακέλου MOVEBAK διαγράφεται και νέα αρχεία BAK θα δημιουργηθούν στον αρχικό φάκελο. 
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12. AutoXlsTable 

 
Δημιουργία πίνακα: Μενού: 

Πίνακας: Εργαλεία Express>AutoXlsTable>Δημιουργία πίνακα

 Καταχώρηση εντολής:_CAOT_AUTOXLSTABLE_CREATE 

 
Βήματα λειτουργίας: 

1. Στο πτυσσόμενο μενού AutoXLSTable, κάντε κλικ στην επιλογή Create Table (Δημιουργία πίνακα). 

2. Δημιουργήστε ένα φύλλο Excel ή ανοίξτε ένα υπάρχον φύλλο Excel 

στο Excel. 

3. Κάντε κλικ στο κουμπί Finish στο πτυσσόμενο μενού AutoXlsTable του Excel. 

4. Καθορίστε το σημείο εισαγωγής στο GstarCAD. 

 

 

 

Επεξεργασία πίνακα: Επεξεργασία: Μενού: Επεξεργασία Πίνακα: Εργαλεία 

Express>AutoXlsTable>Επεξεργασία Πίνακα Είσοδος εντολών: Express tools>AutoXlsTable>Edit Table: 

_CAOT_AUTOXLSTABLE_EDIT Βήματα λειτουργίας: _CAOT_AUTOXLSTABLE_EDIT: 

1. Κάντε κλικ στην επιλογή Επεξεργασία πίνακα. 

2. Επιλέξτε έναν πίνακα που δημιουργήθηκε με το AutoXlsTable στο 

GstarCAD και στη συνέχεια θα ανοίξει το αρχείο Excel. 
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Πίνακας ενημέρωσης: Ενημέρωση πίνακα του οποίου το αρχικό φύλλο Excel τροποποιήθηκε. 

 
Μενού: Εισαγωγή 

εντολής:_CAOT_AUTOXLSTABLE_UPDATETBL 

 
Βήματα λειτουργίας: 

1. Κάντε κλικ στο κουμπί Ενημέρωση πίνακα. 

2. Επιλέξτε τον πίνακα προς ενημέρωση και ο πίνακας 

θα ενημερωθεί αυτόματα σύμφωνα με το σχετικό 

Excel. 

 

 
 

 
Ενημέρωση όλων των πινάκων: 

 
Μενού: Express>AutoXlsTable>Update All the Tables 

(Ενημέρωση όλων των πινάκων): 

CAOT_AUTOXLSTABLE_UPDATEALLTBL 

 
Μετά την εκτέλεση αυτής της εντολής, το σύστημα θα ενημερώσει όλα τα αντικείμενα πίνακα που δημιουργήθηκαν 
 με την εντολή "Δημιουργία πίνακα". 

 
 

 
Διαχείριση συνδέσμων αρχείων: Μπορείτε να χρησιμοποιήσετε αυτή τη λειτουργία για να επεξεργαστείτε, να 

διαχειριστείτε τη σχέση σύνδεσης μεταξύ ενός αντικειμένου πίνακα και ενός εξωτερικού αρχείου EXCEL. 

 
Μενού: Express>AutoXlsTable>Διαχείριση 

συνδέσμων αρχείων Εισαγωγή εντολής: 

Express>AutoXlsTable>Διαχείριση συνδέσμων 

αρχείων: CAOT_AUTOXLSTABLE_MANAGELINK 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε το αντικείμενο πίνακα στο σχέδιο και θα 

εμφανιστεί ένα παράθυρο διαλόγου. 

3. Κάντε κλικ στο κουμπί "Αναζήτηση" για να ανοίξει το 
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παράθυρο διαλόγου επιλογής αρχείου. 

4. Επιλέξτε ένα αρχείο XLS το οποίο πρέπει να συνδεθεί με 

ένα αντικείμενο πίνακα και κάντε κλικ στο "OK", και στη 

συνέχεια επιστρέψτε στο παράθυρο διαλόγου Link 

Manager. 

5. Μπορείτε να χρησιμοποιήσετε τα κουμπιά "Επισύναψη", "Διαγραφή" και "Ενημέρωση" για να ολοκληρώσετε την επεξεργασία και τη 
διαχείριση των συνδέσμων. 

 

 

Ρυθμίσεις διαδρομής: Excel: Αυτή η λειτουργία χρησιμοποιείται για να ορίσετε τη διαδρομή ενός αρχείου Excel. 

 
Μενού: Express>AutoXlsTable>Ρυθμίσεις 

διαδρομής Εισαγωγή εντολής: 

Express>AutoXlsTable>Path Settings: 

CAOT_AUTOXLSTABLE_USINGPATH 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή και θα εμφανιστεί ένα παράθυρο διαλόγου όπως παρακάτω. 

2. Στο παράθυρο διαλόγου, μπορείτε να ορίσετε το μοτίβο διαδρομής του αρχείου Excel. 
 
 

 
Διαχείριση επιλογής: Όταν το μήκος και η περιοχή αλλάζουν, τα δεδομένα υπολογισμού θα ενημερώνονται αυτόματα. 

 
Μενού: Επιλογή Διαχείριση Εντολή Εισαγωγή: 

Express>AutoXlsTable>Selection Management: ΕΠΙΛΟΓΉ: 

CAOT_AUTOXLSTABLE_SELECTION 

 
Σκοπός: χρησιμοποιήστε τη λειτουργία "Διαχείριση επιλογής" για να υπολογίσετε το εμβαδόν ενός κύκλου και ενός 

ορθογωνίου, όταν το μήκος και το εμβαδόν αλλάζουν, τα δεδομένα υπολογισμού θα ενημερώνονται αυτόματα. 

 
1. Σχεδιάστε έναν κύκλο και ένα ορθογώνιο όπως παρακάτω, χρησιμοποιήστε τη λειτουργία "Δημιουργία πίνακα" για να δημιουργήσετε έ ναν 

πίνακα όπως παρακάτω. 
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2. Ξεκινήστε την εντολή "Διαχείριση επιλογής" και θα 

εμφανιστεί ένα παράθυρο διαλόγου. 

3. Εισάγετε το "CIRCLE" και κάντε κλικ στο κουμπί "New Group". 

4. Επιλέξτε τον κύκλο. 

5. Πατήστε enter, το παράθυρο διαλόγου "Διαχείριση 

επιλογής" θα προσθέσει ένα νέο στοιχείο "CIRCLE", 

όπως φαίνεται παρακάτω. 

6. Μπορείτε να προσθέσετε ένα στοιχείο 

"RECTANGLE" χρησιμοποιώντας την ίδια 

λειτουργία όπως παραπάνω. 

7. Κάντε κλικ στο κουμπί "Close" (Κλείσιμο) για να βγείτε από το "Selection Management" (Διαχείριση επιλογών). 

8. Χρησιμοποιήστε την εντολή "Επεξεργασία πίνακα" για να επεξεργαστείτε τον πίνακα. 

9. Κάντε κλικ στο κελί στη δεξιά πλευρά του "CIRCLE" 

και κάντε κλικ στο εικονίδιο "Insert Function", όπως 

φαίνεται παρακάτω: 

10. Στο παράθυρο διαλόγου, μπορείτε να καθορίσετε την οντότητα ως "CIRCLE", το Layer ως "All" και να κάνετε κλικ στο "OK". 
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11. Χρησιμοποιήστε την ίδια λειτουργία για να εισαγάγετε 

τη λειτουργία υπολογισμού της περιοχής ορθογωνίου. Στη 

συνέχεια, κάντε κλικ στο πτυσσόμενο μενού "Finish" (Τέλος) 

του AutoXlsTabl, όπως φαίνεται στην εικόνα. 

12. Επιστρέψτε στο CAD και ο πίνακας θα υπολογίσει το 

εμβαδόν του κύκλου και του ορθογωνίου. 

13. Κλιμακώστε το ορθογώνιο και τα δεδομένα του 

πίνακα θα αλλάξουν αυτόματα. 
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13. Ε ρ γ α λ ε ί α  GstarCAD  

 
Κλίμακα σχεδίασης: Όταν χρησιμοποιείτε άλλα εργαλεία (για παράδειγμα "Γραμμή όπως η χορδή" και "Τροποποίηση 

πλάτους γραμμής"), το λογισμικό μας θα προσαρμόσει αυτόματα την κλίμακα. 

 
Μενού: Express>GstarCAD Εργαλεία>Κλίμακα 

σχεδίασης Εισαγωγή εντολής: 

Express>GstarCAD Tools>Drawing Scale: SASCL 

Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Εισάγετε μια αναλογία σχεδίασης και πληκτρολογήστε για να ολοκληρώσετε. 

Περιστροφή του δρομέα: Ο δρομέας μπορεί να περιστραφεί αριστερόστροφα 

κατά 0 μοίρες ή 45 μοίρες. Μενού: 0 ή 45 μοίρες. 

Είσοδος εντολών: RTCUR0/RTCUR45 
 

 
Side Line:  Μενού: Γραμμή: Express>GstarCAD Tools>Rotate 

Cursor>Side Line Εισαγωγή εντολής: Express>GstarCAD 

Tools>Rotate Cursor>Side Line: RTCUR1 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε το τμήμα αναφοράς και το σύστημα θα ευθυγραμμίσει τον άξονα 

Χ του δρομέα με το επιλεγμένο τμήμα. 

 
Περιστροφή σε πραγματικό χρόνο: 

 
Μενού: Express>GstarCAD Tools>Rotate Cursor>Real Time Rotate 

(Περιστροφή σε πραγματικό χρόνο): RTCUR 

 
Βήματα λειτουργίας: 

1. Μετά την εκτέλεση της εντολής, η γραμμή εντολών εμφανίζει τα παρακάτω μηνύματα. 

2. Μπορείτε να χρησιμοποιήσετε τα τέσσερα πλήκτρα AWSD για να ελέγξετε την κατεύθυνση του δρομέα μέχρι να είστε ικανοποιημένοι κ αι να 
πατήσετε enter. 

 

 

 

Σχεδιάστε αξονομετρική γραμμή: Χρησιμοποιώντας αυτή τη λειτουργία μπορείτε 

εύκολα να σχεδιάσετε ένα αξονομετρικό σχέδιο. Μενού: GstarCAD 
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Εργαλεία>Σχεδίαση αξονομετρικής γραμμής 

Είσοδος εντολών: SALPL 

 

 

Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή και εισαγάγετε την τιμή πλάτους γραμμής. 

2. Η γραμμή εντολών θα σας προτρέψει όπως παρακάτω, εισάγετε τις 

αντίστοιχες επιλογές, μπορείτε να το χρησιμοποιήσετε για να αλλάξετε 

μεταξύ 0 και 45 μοιρών και μπορείτε επίσης να εισάγετε οποιαδήποτε 

τιμή γωνίας. Στη συνέχεια, πατήστε Enter για να ολοκληρώσετε την 

εντολή. 

 
 
 
 
 

 
Οπτική επέκταση: αλλά η οπτική επέκταση μπορεί να εμφανίσει το 

αποτέλεσμα σε πραγματικό χρόνο μέχρι να επιβεβαιώσετε τη θέση. 

 
Μενού: Express>GstarCAD Tools>Visual Extension 

Εισαγωγή εντολής: Express>GstarCAD Tools>Visual 

Extension: ETT 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε τη γραμμή που πρέπει να επεκταθεί, το σύστημα θα επιλέξει αυτόματα την πλησιέστερη πλευρά που 

επιλέξατε ως πλευρά επέκτασης. 

3. Μετακινήστε τον κέρσορα και το τμήμα θα επεκταθεί σε πραγματικό χρόνο. 
 

 
Κανονική σύνδεση: Μπορεί να διαγράψει τις γραμμές της πραγματικής διασταύρωσης ή τα τμήματα φαινομενικής 

διασταύρωσης. 

 
Μενού: Σύνδεση: Express>GstarCAD Tools>Normal 

 Connect

Είσοδος εντολής : 

Express>GstarCAD Tools>Normal Connect : GXFILT 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε το πρώτο τμήμα γραμμής. 

3. Επιλέξτε τη δεύτερη γραμμή. 

4. Το αποτέλεσμα θα είναι όπως φαίνεται στην εικόνα. 
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Flex Connect: Αυτή η λειτουργία μπορεί να επεκτείνει ή να περικόψει τη γραμμή μέχρι το πραγματικό σημείο 

διασταύρωσης ή το προφανές σημείο διασταύρωσης. Μενού: Express>GstarCAD Tools>Flex Connect 

Είσοδος εντολών: GXFSS 

 
Δείγμα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε την επιμήκυνση (ή τη συντόμευση) της γραμμής. 
 

 
Σούπερ φιλέτο: και το ενοποιημένο πρότυπο θα λάβει το πρώτο 

επιλεγμένο αντικείμενο φιλέτου ως αναφορά. 

 
Μενού: Εισαγωγή εντολής: 

Express>GstarCAD Tools>Super Fillet: 

SFILLET 

Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή και εισαγάγετε την ακτίνα φιλέτου. 

2. Επιλέξτε το πρώτο τμήμα, όπως φαίνεται παρακάτω. Μετά την εκτέλεση της εντολής, το στρώμα, το χρώμα, ο τύπος 

γραμμής μιας άλλης γραμμής και το φιλέτο θα ταιριάζουν με το πρώτο τμήμα. 

3. Επιλέξτε το δεύτερο τμήμα. 

 
Τροποποίηση του πλάτους γραμμής: Τροποποιήστε το πλάτος γραμμής που καθορίσατε, εάν αυτό που καθορίσατε είναι 

μια γραμμή και το λογισμικό μας θα μετατρέψει τη γραμμή σε Pline αυτόματα και θα αλλάξει το πλάτος γραμμής. Αυτή η 

λειτουργία είναι παρόμοια με τη λειτουργία pedit, μπορούμε να τη χρησιμοποιήσουμε ως έκδοση συντόμευσης και 

είναι πολύ βολική για την τροποποίηση του πλάτους γραμμής. 

 
Μενού: Εισαγωγή εντολής: Express>GstarCAD 

Tools>Modify Linewidth: LCW 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε τη γραμμή. 

3. Εισάγετε μια νέα τιμή πλάτους γραμμής και εδώ εισάγουμε "2" για παράδειγμα. 

4. Πληκτρολογήστε για να ολοκληρώσετε και το αποτέλεσμα θα είναι όπως φαίνεται στην εικόνα. 
 
 

 
Σταυρός για να σπάσει: Στα μηχανολογικά σχέδια, σε πολλά σημεία πρέπει να σπάσει η γραμμή του σταυρού. Αν το 

κάνουμε αυτό με τον αρχικό τρόπο, θα είναι πολύ περίπλοκο. Χρησιμοποιώντας αυτή τη λειτουργία το σπάσιμο 

των γραμμών μπορεί να γίνει εύκολα. 
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Μενού: Express>GstarCAD Tools>Cross to Break 

Εισαγωγή εντολής: CBK 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε τη γραμμή απόκρυψης. 

3. Επιλέξτε την αποκρυπτόμενη (προς αποσύνδεση) γραμμή και αυτό που 

επιλέξατε θα αποκοπεί αυτόματα. 

4. Enter για να ολοκληρώσετε την εντολή. 
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Πλάτος διαχωρισμού ελέγχου: Αυτή η λειτουργία χρησιμοποιείται για τον ορισμό του πλάτους διαχωρισμού για αντικείμενα σταυρού. 

 
Μενού: Express>GstarCAD Εργαλεία>Πλάτος διακοπής 

ελέγχου Εισαγωγή εντολής: Express>GstarCAD 

Tools>Control Break Width: CBKWID 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Πληκτρολογήστε το πλάτος του χώρου διαλείμματος. 

 

Τροποποίηση κειμένου: Εδώ μπορείτε να βρείτε διάφορα εργαλεία για 

να τροποποιήσετε τις ιδιότητες του κειμένου. Ύψος κειμένου: 

Μενού: Εργαλεία Express>GstarCAD Εργαλεία>Τροποποίηση 

κειμένου>Ύψος κειμένου Εισαγωγή εντολής: Είσοδος: TXT40 

 
1. Ξεκινήστε την εντολή. 

2. Επιλέξτε ένα μονόγραμμο κείμενο. 

3. Ύψος κειμένου εισαγωγής. 

4. Πατήστε enter για να ολοκληρώσετε την εντολή. 
 
 
 
 
 

 
Συντελεστής πλάτους: 

Μενού: GstarCAD>Εργαλεία>Τροποποίηση 

κειμένου>Συντελεστής πλάτους 

Είσοδος εντολών: TXT41 

 
1. Ξεκινήστε την εντολή. 

2. Επιλέξτε ένα μονόγραμμο κείμενο. 

3. Αναλογία ύψους πλάτους εισόδου. 

4. Πατήστε enter για να ολοκληρώσετε την εντολή. 
 
 

 
Γωνία: 

Μενού: Γωνία Εισαγωγή εντολής: Express tools>GstarCAD 

Tools>Modify Text>Angle: TXT50 

 
1. Ξεκινήστε την εντολή. 

2. Επιλέξτε ένα μονόγραμμο κείμενο. 

3. Γωνία περιστροφής εισόδου. 

4. Πατήστε enter για να ολοκληρώσετε την εντολή. 
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Γωνία λοξότητας: Μετά την εκτέλεση της εντολής, το κείμενο θα αποκτήσει ένα εφέ παραμόρφωσης με κλίση. 

 
Μενού: Εργαλεία Express>GstarCAD Εργαλεία>Τροποποίηση 

κειμένου>Γωνία κλίσης Εισαγωγή εντολών: TXT51 

 
1. Ξεκινήστε την εντολή. 

2. Επιλέξτε ένα μονόγραμμο κείμενο. 

3. Γωνία κλίσης εισόδου. 

4. Πατήστε enter για να ολοκληρώσετε την εντολή. 
 
 

 
Επιλογές Τροποποίηση: Μπορείτε να χρησιμοποιήσετε αυτή τη λειτουργία για να τροποποιήσετε όλες τις παραπάνω επιλογές. 

 
Μενού: Εργαλεία Express>GstarCAD Εργαλεία>Τροποποίηση 

κειμένου>Επιλογές Τροποποίηση εντολής Εισαγωγή: EDTXT 

Super Axonometric: Πρόκειται για μια βασική λειτουργία που μπορεί εύκολα να μετατρέψει ένα σχέδιο κάτοψης σε 

αξονομετρικό σχέδιο. Μενού: Express>GstarCAD Tools>Super Axonometric 

Είσοδος εντολών: ZC Βήματα 

λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε αντικείμενα και πατήστε enter, όπως φαίνεται παρακάτω. 

3. Εισάγετε το αξονομετρικό σημείο θέασης, όπως 45 μοίρες. 

4. Το αποτέλεσμα θα είναι το ακόλουθο. 
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14. Εργαλεία Plot 

Εκτύπωση PLT: Οι χρήστες μπορούν να στείλουν αρχεία PLT 

στον εκτυπωτή για εκτύπωση. Μενού: Εκτύπωση PLT 

Είσοδος εντολών: PrintPlt 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Επιλέξτε PrintPlt.exe στο παράθυρο διαλόγου. 

3. Κάντε διπλό κλικ στο αρχείο PrintPlt.exe, τότε θα εμφανιστεί το 

παράθυρο διαλόγου "Εκτύπωση", στο οποίο μπορείτε να επιλέξετε 

εκτυπωτή ή να αλλάξετε τις ρυθμίσεις. 

4. Κάντε κλικ στο κουμπί OK, θα εμφανιστεί το παράθυρο διαλόγου "Άνοιγμα" και μπορείτε να επιλέξετε το εκτυπωμένο αρχείο. 
 
 

 
Εκτύπωση παρτίδας: Παρτίδα εκτύπωσης σχεδίων με το ίδιο 

χαρακτηριστικό πλαίσιο σχεδίασης. 

 
Μενού: Εργαλεία Express>Εργαλείο 

σχεδίασης> Εκτύπωση παρτίδας 

Εισαγωγή εντολής: BP 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή. 

2. Καθορίστε τον τύπο του πλαισίου. Μπορείτε να επιλέξετε Layer/ 

Block/ Polyline, ώστε το σύστημα να μπορεί να αναγνωρίσει το 

πλαίσιο. 

3. Corner επιλέξτε το πλαίσιο που θέλετε να εκτυπώσετε, θα εμφανιστεί ένα παράθυρο διαλόγου. 

4. Ορίστε τις παραμέτρους εκτύπωσης και κάντε κλικ στο "OK" για να εκτελέσετε την εκτύπωση λουτρού. 
 

 
Τακτοποίηση πλαισίου αυτόματα: και στη συνέχεια να τακτοποιήσει 

διάφορα σχέδια σε ένα μεγάλο σχέδιο. 

 
Μενού: Εισαγωγή εντολής: Express tools>Εργαλείο σχεδίασης>Αρχή 

πλαισίου αυτόματα: FRAMEAR 

 
Βήματα λειτουργίας: 

1. Ξεκινήστε την εντολή, θα εμφανιστεί ένα παράθυρο διαλόγου. 

2. Προκειμένου να έχετε μια λογική ρύθμιση του οικοπέδου 

σχεδίασης, μπορείτε να επιλέξετε εκ των προτέρων ποια 

βιομηχανία θέλετε να χρησιμοποιήσετε. Κάντε κλικ στο "Options" 

(Επιλογές) και θα εμφανιστεί ένα παράθυρο διαλόγου. 
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3. Κάντε κλικ στο κουμπί "Εισαγωγή αρχείων", θα εμφανιστεί ένα παράθυρο 

διαλόγου "Προσθήκη αρχείου Τρόπος", μπορείτε να ορίσετε τον τρόπο που 

θέλετε να προσθέσετε στο αρχείο. 

Φάκελος: Εάν επιλέξετε την επιλογή "Αρχείο που περιέχει υποφακέλους", όλα τα αρχεία 

DWG από τους υποφακέλους θα προστεθούν στην ταξινομημένη λίστα. 

Κατάλογος κλήρωσης: Προσθήκη 

καθορισμένης λίστας αρχείων LST. 

Αρχείο: Προσθήκη καθορισμένου 

αρχείου DWG. 

 
4. Μετά την επιλογή, όλα τα αρχεία θα εμφανιστούν στη λίστα. 

5. Κάντε κλικ στο κουμπί "Προεπισκόπηση" για προεπισκόπηση του 

αποτελέσματος της διάταξης. Το σύστημα θα τακτοποιήσει τα σχέδια 

έξυπνα σύμφωνα με το παραπάνω πλαίσιο. 

6. Εάν είστε ικανοποιημένοι με το αποτέλεσμα, μπορείτε να κάνετε 

κλικ στο "OK" και, στη συνέχεια, το σύστημα θα τακτοποιήσει τα 

σχέδια και θα εισάγει τα πλαίσια σχεδίασης στο τρέχον αρχείο. 
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